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Finding Answers to Commonly Asked Questions    1 

In this Getting Started Guide, you can find answers to questions about the 
following topics: 

• Turning on the PC, page 5 
• Registering your PC, page 7 
• Transferring information to your new PC, page 7 
• Using desktop icons, page 8 
• Customising special buttons on the keyboard, page 19 
• Connecting to the Internet, page 5 
• Connecting to a TV, page 41 
• Getting digital pictures onto your PC, page 39 
• Playing a music CD, page 47 
• Watching a DVD movie, page 48 
• Creating a CD, page 53 
• Creating a DVD, page 71 
• Finding help if something doesn’t work, page 79 

 

NOTE: This guide contains details on options that may not be included with your 
PC. Your PC may look different from the illustrations in this guide. The monitor and 
the speakers may be sold separately. Speakers may be included with the monitor 
(select models only). 

Finding Answers to Commonly Asked 
Questions 
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WARNING: Please read “Safety Information” in the Warranty and 
Support Guide before installing and connecting your PC to the 
electrical power system. 

 

Putting Your PC Together 
Follow the steps on the quick setup poster to set up your PC. 

Look in the PC box for printed details or updates regarding your model PC. 

When placing your PC, consider an ergonomic arrangement of the PC and your 
work area to maintain your comfort and productivity. Refer to “Setting up for 
safety and comfort” on page 3. 

 

 
WARNING: The power supply is pre-set for the country/region in 
which you purchased your PC. If you move, please check the 
voltage requirements before plugging your PC into an AC power 
socket. 

 

Setting up for safety and comfort 
After assembling your PC, but before you begin using it, arrange the PC and your 
work area to maintain your comfort and productivity. Refer to the Safety & 
Comfort Guide for important ergonomic information. 

 

 
WARNING: To reduce the risk of serious injury, read the Safety & 
Comfort Guide. It describes proper workstation setup, posture, and 
health and work habits for computer users. It also provides 
important electrical and mechanical safety information. 

 

Setting Up Your PC 
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To view the Safety & Comfort Guide: 

• Click Start, choose All Programs, choose PC Help & Tools, and then click 
Safety & Comfort Guide. 

Or 

• Type 
http://www.compaq.com/ergo/ 
into your Web browser address box, and then press Enter on the keyboard. 

 

Connecting to the PC 
Connect your main hardware devices like the monitor, keyboard and mouse at the 
back of the PC. Other peripheral devices like a printer, scanner, camera or other 
equipment also plug into connectors on the back of your computer. Some PC 
models also have connectors on the front of the PC. 

 

Connector 
symbol 

 
Description  

 
Mouse (PS/2)  

 Keyboard (PS/2)  

 

Universal Serial Bus (USB) for mouse, keyboard, digital cameras, or 
other devices with USB connectors  

 
Printer (parallel)  

 
Monitor  

serial Serial port for some digital cameras or other serial devices 

OUT 

Audio Line Out (powered speakers)  

IN  

Audio Line In  

 Headphones  

 
Microphone  

 
FireWire® (IEEE 1394) for video cameras or other devices with very fast 
transfer rates  

 

Your PC features and 
connector positions 
may vary. 
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Turning on Your PC for the First Time 
After you have completed the steps on the quick setup poster, you are ready to 
turn on your PC. 

1 Press the Power button on the monitor. 
2 Press the On button on the front of the PC. 
3 Turn on the speakers, if they are present. 
4 Click an option to select your language (if applicable for your model). Click 

OK and then confirm your selection by clicking Yes. Wait until the PC makes 
preparations. (It may take up to 30 minutes to set up the language on the PC.) 

5 Set up Microsoft® Windows® by following the onscreen instructions. 
6 Double-click the large Internet Access icon on your desktop, if it is present. 

Wait until the PC displays the Easy Internet Sign-up window, and then follow 
the onscreen instructions. 

7 Register your PC; see “Registering Your PC” on page 7. 
 

Setting Up and Connecting to Your 
Internet Account 
Before you can connect to the Internet, you must sign up with an Internet 
Service Provider (ISP). Compaq has made arrangements with leading ISPs to 
help you sign up for Internet service using Easy Internet Sign-up (available on 
select models only). 

NOTE: However, you may choose any other ISP of your choice, or transfer your 
existing ISP account to this PC. 

Use Easy Internet Sign-up to sign up for a new or an existing ISP account. The 
software programs for available ISPs are part of your PC. If you decide to 
subscribe to high-speed broadband (cable or DSL), contact your ISP for any 
specific software and hardware you may need. 

 

1 Make sure the modem or other Internet access cable is connected. 
 

NOTE: Easy Internet Sign-up finds and obtains updated information about 
services by connecting to the Internet. The PC uses either the PC modem 
connected to an active telephone service line or an active broadband (cable 
or DSL) connection. 
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2 Choose an ISP using Easy Internet Sign-up. To open Easy Internet Sign-up: 
a Double-click the Easy Internet Sign-up icon on the desktop. 

Or 
Click Start on the taskbar, choose All Programs, choose Online 
Services, and then click Easy Internet Sign-up. 

b Follow the onscreen instructions. 
 

NOTE: The folder called Online Services includes icons for accessing various 
online services, but they may not be present in all countries/regions. 

 

3 Connect to your ISP and the Internet. 
Use one of these methods: 
• Double-click the ISP-provided icon on the desktop. 
Or 
• Press the Connect (or Internet) button on the keyboard (select 

models only). 
Or 
• If your PC is always connected to your ISP, open your browser program, 

such as Internet Explorer: Click Start, choose All Programs, choose 
Online Services, and click Internet Explorer. 

 

NOTE: If you are using MSN or AOL, and have questions, contact the ISP 
directly. 

 

Installing Software and Hardware Devices 
After you turn on the PC the first time, you can install any software programs that 
came on CDs or DVDs included in the PC box (select models only). 

You may wish to install additional software programs or hardware devices on 
your PC. Before installation, make a restore point using the Microsoft System 
Restore program; refer to “Recovering from Software Problems” in the Warranty 
and Support Guide. Restart the PC after installation. 

Choose software that is compatible with your PC — check the operating system, 
memory, and other requirements listed for the new software for compatibility with 
your PC. 

NOTE: Only use original licensed software. Installing copied software may be 
illegal or may infect your PC with a virus. 

Install the new software according to the directions provided by the software 
manufacturer. Check the manufacturer’s documentation or customer service 
information for help if you need it. 
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Transferring your old PC information and files 
to your new PC 
See the built-in Microsoft Windows Help and Support Center; search for transfer 
wizard, and select the overview article, Files and Settings Transfer Wizard 
overview. This information describes a Microsoft solution for moving your files 
onto your new PC. 

Or, as an alternative, double-click the PC Tune Up & Repair icon (select 
models only) in the Help and Support Center, and review the products and 
services offered under Backup Data. 

Making recovery discs 
Now is a good time to make your recovery discs. Refer to the Warranty and 
Support Guide for instructions and more information. 

Registering Your PC 
Registration is quick and easy, and it offers you access to subscriptions and 
notifications such as: 

• E-mail updates containing notifications about product enhancements, the most 
recent support alerts and driver updates specific to the products you own. 

• The HP newsgram, our monthly online magazine packed full of product news, 
support tips, project ideas, and much more. Visit 
http://subscription.support.hp.com 

 

NOTE: You can view your PC product number, model number, and serial number, 
by pressing the Ctrl, Alt and S keys on the keyboard at the same time. 

To register your PC: 

• Click the Register with Compaq icon on the desktop. When you 
use the desktop icon, the PC automatically fills in the PC product 
number, model number and serial number for you. 

Or 
• Go to http://register.hp.com 
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Using Desktop Icons 
The desktop has shortcut icons that make it easy to find the things you need. 

 

Icon Opens Use it to 

 

Help and Support (select 
models only) 

View onscreen Help information 
about your PC. 

 

Easy Internet Sign-up Set up a new or an existing Internet 
account. 

 

Software Repair Wizard 
(select models only) 

Repair software problems with 
programs, printers, or peripherals 
that stop working, or resolve erratic 
PC behaviour; repair options include 
using Application or System 
Recovery. 

 

Register with Compaq Register both your Compaq PC and 
all your Compaq products. 

 

Compaq Organise (select 
models only) 

Organise your PC shortcuts and your 
favourite Internet destination links. 

 

Using Compaq Organise software 
Compaq Organise software (select models only) is a desktop tool you use to 
organise both your PC shortcuts and your favourite Internet destination links. You 
use it to organise the important things you do on the PC and the Internet, and to 
arrange them the way you want. Compaq Organise makes all your information 
available with just a few mouse clicks. 

Compaq Organise looks like a window with multiple category frames. Each 
category has links to Internet destinations or shortcuts to software programs or files 
on your PC. Use the player area for viewing pictures, for listening to your MP3 
music files stored on your computer, or for watching video clips. For searching, 
there is a search bar at the top of Compaq Organise where you can select the 
search engine you want to use. 
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To open Compaq Organise: 

Double-click the desktop icon. 

Or 

1 Click Start on the taskbar. 
2 Choose All Programs. 
3 Click Compaq Organise. 

Using PC Help & Tools 
The PC Help & Tools folder (select models only) in the All Programs menu contains 
special utilities for PC owners. This folder also contains any onscreen guides 
included with your PC. 

To see the items in the PC Help & Tools folder: 

1 Click Start on the taskbar. 
2 Choose All Programs. 
3 Choose PC Help & Tools. 
4 Click an item to view it or use it. 

 

NOTE: If there are no guide titles listed in PC Help & Tools, your PC has no 
onscreen guides. 
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Your keyboard has an arrangement of standard keys, indicator lights and special 
buttons (select models only). Locate your keyboard among the following 
illustrations, and read the feature list for it. Your keyboard may vary from the 
illustrations. 

Using the Internet Keyboards 
Internet keyboards may connect directly to your PC or may be wireless. 
(See ”Using the Wireless Keyboard Set” on page 14 for a description of the 
wireless set.) 

Some keyboards do not have the Internet buttons shown here at the top of the 
keyboard, and some use a different layout on the top right. 

Find your keyboard among the following illustrations to read about its features. 

Using the Keyboard 
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Internet keyboard 1 

 

This keyboard enables you to: 

• Adjust speaker volume. 
• Connect to the Internet (if you have an established Internet account). 
• Search for information on the Internet. 
• Place the PC into standby mode to save power. 
• Start, pause, and stop playing a CD or DVD; skip to the previous or next track; 

record; and eject the disc tray (for two drives). 
• Mute speaker sound. 
• Customise the buttons to open programs, and connect to Internet Web sites. 
• Get support information. 
• Find a file or program on the hard disk drive. 

 

Internet keyboard 2 

 

This keyboard enables you to:  

• Connect to the Internet (if you have an established Internet account). 
• Search for information on the Internet. 
• Customise the buttons to open programs and connect to Internet Web sites. 
• Get support information. 
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Internet keyboard 3 

e-mailsearchconnect club

 

This keyboard enables you to: 

• Adjust speaker volume. 
• Customise the buttons to open programs and connect to Internet Web sites. 
• Search for information on the Internet. 
• Find a file or program on the hard disk drive. 
• Open a calculator. 
• Place the PC into standby mode to save power. 
• Connect to the Internet (if you have an established Internet account). 
• Mute speaker sound. 
• Get support information. 

 

Using the Standard Keyboard 
 

A B C

 

This keyboard enables you to: 

• Adjust speaker volume. 
• Place the PC into standby mode to save power. 

 

LEDs, light emitting 
diodes, are lights used 
to indicate status. 

A The lights (LEDs) turn 
on to indicate (left to 
right) the number lock 
on, the capitals lock 
on, and the scroll 
lock on. 

B The plus (+) and 
minus (–) buttons 
adjust the speaker 
volume. 

C The moon icon 
button  places the 
PC into standby mode 
or wakes the PC from 
standby mode. 
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Using the Wireless Keyboard Set 
A wireless keyboard (B) uses a receiver/transmitter unit (A), instead of a 
connector cable, to communicate with your PC. The wireless keyboard, mouse (C), 
and receiver set is available with select models only. 

 

 

A light (D) on the receiver indicates receiver activity. 
 

 

 

Identifying Special Keyboard Buttons 
There are special buttons (select models only) at the top of the keyboard. (Some 
models have some of these special buttons on the left side of the main keys.) These 
buttons operate a CD or DVD player, connect you to the Internet, or provide quick 
access to specific functions. 

 
A Wireless receiver 
B Wireless keyboard 
C Wireless mouse 

 
A Number lock on 
B Capitals lock on 
C Scroll lock on 
D Receiver activity 



 

Using the Keyboard    15 

Internet keyboard 1 

NOTE: The number, location, and labelling of buttons vary by keyboard model. 

Figure 
key 

 
Icon 

 
Feature 

 
Description 

A 
 

Standby Puts PC into power-saving mode (screen is blank but PC is still on). To 
make screen reappear, press the Esc key, or press standby again. May 
take 10–30 seconds before screen reappears. 

B  User Switches between the PC users. 

C Compaq Compaq  Links to Compaq Web site. 

D 
 

Help Opens the Help and Support Center. 

E 
  

My Pictures Opens an imaging software program. Can be reconfigured. 

F 
   

Music Starts iTunes or Windows Media Player. Can be reconfigured. 

G  Video Opens video software program. Can be reconfigured. 
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Figure 
key 

 
Icon 

 
Feature 

 
Description 

H 
   

Shopping 

K 

   

Sports 

M 

   

Finance 

N 

   

Connect 

P 
   

Search 

R 

   

Chat 

S 
 

E-Mail 

Goes to popular Web sites. Can be reconfigured to open a site or 
software program. 

T See figure 
following table 

Media controls 
(CD/DVD/MP3) 

Operates CD or DVD player. 

V  Volume control 
(Volume knob or 
Volume Up and 
Volume Down 
buttons) 

Volume knob: Increases speaker volume when turned clockwise and 
decreases volume when turned anticlockwise. It can be turned 
indefinitely, even after maximum sound has been reached. 
Volume Up and Down buttons: Press the Volume Up  button to 
increase volume and the Volume Down  button to decrease volume. 

W 

   

Mute Turns speaker sound on and off. 

 

Media control keys 
 

 

NOTE: The number, location, and labelling of buttons vary by keyboard model. 

 

 
a Open and close disc 

tray(s) 
b Record 
c Play or pause 
d Stop 
e Skip to the previous 

track 
f Skip to the next track 
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Internet keyboard 2 
 

 

Figure 
Key 

 
Icon 

 
Feature 

 
Description 

A 
 

Internet Connects you to a customisable Web page filled with local weather, news, sports, 
and financial information. Can be reconfigured to open a site or software program. 

B 
 

Help Takes you to the Help and Support Center. 

C 
 

Search Opens a Web site that helps you locate information on the Internet. Can be 
reconfigured to open a site or software program. 

D 
 

E-Mail Starts your e-mail program. Can be reconfigured to open a site or software program. 

E 
 

Offers Launches an online community experience with chat, discussion boards, clubs, and 
more. Can be reconfigured to open a site or software program. 

F 
 

Entertainment Connects you to the world of entertainment, featuring music downloads, streaming 
video, Webcasts, entertainment news, and reviews. 

G 

 

My Presario Takes you to the My Presario Club Web site, featuring a variety of discounts, 
promotions, and how-to information. 

H 
 

Shopping Provides a connection to your PC store. Can be reconfigured to open a site or 
software program. 
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Internet keyboard 3 

 
 

Figure 
key 

 
Icon 

 
Feature 

 
Description 

A 
 

Standby Puts PC into power-saving mode (screen is blank but PC is still on). To 
make screen reappear, press the Esc key, or press standby again. May 
take 10–30 seconds before screen reappears. 

B 
 

Connect Goes to a Web site. Can be reconfigured to open a site or software 
program. 

C 
 

Search Opens a Web site that helps you locate information on the Internet. 
Can be reconfigured to open a site or software program. 

D  E-Mail Starts your e-mail program. Can be reconfigured to open a site or 
software program. 

E 
 

Compaq  Links to Compaq Web site. 

F 

 

Help Opens the Help and Support Center. 

G 

 

Calculator Opens the calculator. Can be reconfigured. 

H 
 

Volume Adjusts volume. 

K 
 

Mute Mutes sound. 

 



 

Using the Keyboard    19 

Customising the keyboard buttons 
You can customise some of the special buttons on the keyboard (select models 
only) to open different programs or files, or to connect to favorite Web sites: 

1 Click Start on the taskbar. 
2 Choose Control Panel. 
3 Click Printers and Other Hardware, if it is present. 
4 Double-click Keyboard. 
5 On the Buttons tab, double-click the button you want to change. 
6 For the Button configuration, click the down-arrow to the right of the list and 

choose the button capability, such as Simple web page with label. 
7 Enter a display label and the address information. For a Web page, enter 

the URL. 
8 Click OK. 
9 On the Buttons tab, click Apply. 

10 Repeat steps 5 to 9 for each button you want to customise. 
11 Click OK to finish. 

 

NOTE: Clicking the Restore Defaults button on the Button tab restores all of the 
Internet buttons to the factory settings. 
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Getting Help    21 

Recovering from Software Problems 
The PC uses the operating system and installed software programs during normal 
operation. If your PC works improperly or stops because of the software, you may 
be able to repair it by restarting the PC, using System Restore, or using other 
methods including the system recovery programs. 

You need recovery discs (CDs or DVDs) for some repairs that use the Compaq 
Application Recovery program or the Compaq System Recovery programs. Now 
is a good time to make your recovery discs. 

For instructions on making recovery discs, repairing and recovering your software, 
and more information, refer to the Warranty and Support Guide that came with 
your PC. 

Using the Onscreen Help and 
Support Center 
Information about your PC is in the onscreen Help and Support Center (select 
models only). Here you can find links to driver updates, access to technical 
support options, and information about commonly asked questions. 

To open the Help and Support Center: 

1 Press the Help button (select models only) on your keyboard. 
Or 
Click Start on the taskbar and choose Help and Support. 

2 Click Presario PC help. 
 

Getting Help 
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Using Instant Support 
When you need assistance to solve a PC-related problem, use Instant Support 
(select models only). With Instant Support you can run tests or submit a problem 
for help over the Internet. When you submit a problem, you communicate over the 
Internet with a Support analyst who works with you on solving the problem. 

To start Instant Support: 

1 Click Start on the taskbar. 
2 Click Help and Support. 
3 Click Connect to Customer Support. 
4 Click Start a New Request. 
5 Follow the onscreen instructions to run a test or submit a problem. (Your PC must 

be connected to the Internet to submit a request.) 
 

Using Compaq Connections 
Compaq Connections (select models only) is an Internet-based service that brings 
you important information for your PC: 

• Product notices 
• System updates 
• Tips 
• Special offers for your PC 

 

Messages arrive while you’re connected to the Internet, and may display an alert 
or a notice on your desktop. View messages as they arrive, or read them later. 

Most Support updates delivered by Compaq Connections messages are also 
available to you through the Support Web site under the information for your PC 
model. 

Getting messages 
After you view or close a message, it will not automatically display again. 

To read a previously received message, open Compaq Connections: 

1 Click Start on the taskbar. 
2 Choose All Programs. 
3 Choose PC Help & Tools. 
4 Choose Compaq Connections. 
5 Click Compaq Connections again. 

 

Compaq Connections opens and lists the message titles. To read a message, 
double-click the message title in the window. You can close this window, and 
Compaq Connections remains active. 
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Turning off messages 

NOTE: You cannot receive Compaq Connections messages, including important 
Support messages that may be critical to the operation of your PC, while the 
service is off. 

To turn off the Compaq Connections Service: 

1 Click Start on the taskbar. 
2 Choose All Programs. 
3 Choose PC Help & Tools. 
4 Choose Compaq Connections. 
5 Click Disable Compaq Connections. 

The service is turned off until you re-enable it. 
 

Re-enabling messages 
When you re-enable the Compaq Connections Service, the service runs whenever 
you are connected to the Internet, and you automatically receive messages as they 
become available. 

To turn on the service: 

Double-click the Re-enable Compaq Connections icon on the desktop. 

Or 

1 Click Start on the taskbar. 
2 Choose All Programs. 
3 Choose PC Help & Tools. 
4 Choose Compaq Connections. 
5 Click Re-enable Compaq Connections. 

 

Finding Online Guides 
You can find online guides and information for your PC. 

To view online manuals for your PC, go to the Support Web address listed in 
the Warranty and Support Guide and search for your product name and number. 
The product number is on the lower front of the PC chassis or inside the CD 
storage area. 

NOTE: Online manuals are associated with specific PC model numbers. Some 
models do not have online manuals. 
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Finding Web Sites about your PC 
Use the Web site addresses listed in the Warranty and Support Guide for: 

• Information about your PC. 
• Your technical support needs. 

 

Type these Web site addresses into the address box of your Internet browser, and 
then press the Enter key on your keyboard. 

Finding More Help 
If you need additional help, see the Warranty and Support Guide that came with 
your PC. 
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The HP Personal Media Drive (sold separately) can be used as an internal or 
external USB hard disk drive, designed to quickly and easily increase your 
storage capacity, and to transfer media files such as digital photos, music, videos, 
and other important files. You can also use the HP Personal Media Drive to back 
up other drives on your PC. 

 

Connecting the Drive 
As an external drive, the HP Personal Media Drive connects and disconnects 
easily from a USB 2.0 connector on the front or the back of most PCs. The drive 
comes with software, an external USB cable, and an external power cable and 
power adapter. For information about connecting and using the HP Personal 
Media Drive as an external drive, refer to the documentation that came with the 
HP Personal Media Drive. 

Using the HP Personal Media Drive 
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For some HP and Compaq PCs (select models only), the HP Personal Media Drive 
is designed to fit inside a horizontal or vertical drive bay. 

 

This special drive bay includes an internal USB port and power cable that connect 
to the drive when it is inserted. 

The drive turns on when it is plugged into an active USB port. If the PC is turned 
on with the drive connected, the drive automatically turns on. When the USB cable 
for the drive is not plugged in or when the USB power from the PC is turned off, 
the drive automatically turns off. When the PC is in standby mode (a reduced 
power state), the drive remains turned on. 

 

 
WARNING: Do not move the PC with the HP Personal Media Drive 
inserted in the bay or connected to a USB port on the PC. This can 
cause damage to the drive and cause data loss. 

 

NOTE: The drive can 
be easily inserted and 
removed from the bay 
without turning off the 
PC. This feature is 
sometimes referred to 
as warm swappable. 
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Inserting the Drive 
1 Turn on the PC. 
2 Line up the ridges on the bottom of the drive with the two slots on the side or 

the bottom of the PC drive bay. Do not force the drive into the bay; it should 
slide easily into the bay. 

3 Slide the drive all the way into the drive bay until the drive is firmly connected 
to the internal power and USB port. With the PC turned on, the power indicator 
(B) on the front of the drive is lit when the drive is inserted correctly. 

 

 

Locating the Drive and Assigning a 
Drive Letter 
After you insert the drive into the PC, you can find the drive in My Computer. The 
operating system automatically assigns a letter to the drive. The assigned letter 
depends on the other storage devices connected to the PC. 

To locate the drive: 
1 Click Start on the taskbar. 
2 Click My Computer. 
3 Select the drive under Hard Disk Drives. The default name is HP Personal 

Media Drive. 
 

The default volume label of this drive is HP Personal Media Drive. You can rename 
the drive in the My Computer window by right-clicking the drive, selecting 
Rename, and then typing in a new name. Rename the drive if you have more 
than one HP Personal Media Drive. 

A Drive activity 
indicator light 

B Power on indicator 
light 

C HP Personal Media 
Drive guide ridges 
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You can permanently assign a drive letter to avoid the letter changing when you 
connect and disconnect this drive and other devices. Also, it is easier for a 
software program to locate the files on the HP Personal Media Drive if a drive 
letter is assigned. Some programs may not be able to find files if the drive has a 
new drive letter. 

It is best to always remove your drive safely to avoid errors. See “Disconnecting 
the Drive” on page 29. 

To assign a drive letter: 
1 Click Start on the taskbar. 
2 Right-click My Computer. 
3 Select Manage and then click Disk Management. 
4 Right-click the HP Personal Media Drive. 
5 Select Change Drive Letter and Paths. 
6 Click Change and select a letter, and then apply the changes by clicking OK. 

 

Using the Drive 

To store files: 
The best way to transfer files to the HP Personal Media Drive is to drag them from 
your local hard disk drive. This allows you to place files in specific folders. Refer 
to the following procedures for more detailed instructions about creating linked 
folders. 

To play media files: 
You can play all kinds of media from an HP Personal Media Drive. 

1 Click Start on the taskbar. 
2 Click My Computer. 
3 Double-click the HP Personal Media Drive icon to locate your media file. 
4 Double-click the file. Most media files open in Windows Media Player. 

 

To play music files: 
You can play all kinds of music files that are stored on the HP Personal Media 
Drive. 

1 Click Start on the taskbar, click My Computer, and then double-click the 
HP Personal Media Drive icon. 

2 Create a personal music folder by right-clicking the drive window and choosing 
New and then Folder. Type a name for your personal music folder. 

3 Drag or copy your music files into this created folder. 
4 Open Windows Media Player by clicking Start, All Programs, and then 

clicking Windows Media Player. 

NOTE: To avoid multiple 
hard disk drives using 
the same drive letter, 
when connecting and 
removing the drives, 
assign the letter Z. 
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5 In the Windows Media Player window, click Tools, select Options, and then 
select the Media Library tab. 

6 Click the Monitor Folders button. 
7 Click Add to add a pathway to your HP Personal Media Drive. 
8 Browse to locate your created music file folder on your HP Personal Media 

Drive, and then click OK. 
9 Click OK, and then OK again to close the Options window. Now your music 

files on your HP Personal Media Drive appear in the Windows Media Player 
library when your drive is connected to the PC. 

 

When you disconnect the drive, your music files may still appear in the Windows 
Media Player Library. To refresh your PC, open and close Windows Media 
Player. If that doesn’t work, restart the PC. 

Disconnecting the Drive 
You can safely remove the drive when it is not active. When the amber activity 
light is blinking, the drive is active, saving or transferring data. Removing the drive 
while the light is blinking may cause data loss or damaged files. 

To disconnect the HP Personal Media Drive safely: 

1 Close all programs that may be accessing your HP Personal Media Drive. 
Make sure that the activity light on the drive is off. 

2 Double-click the Safely Remove Hardware icon in the system tray 
(on the Start taskbar). If this icon is hidden, click the arrows on the 
taskbar to display it. The Safely Remove Hardware window opens. 

3 Double-click USB Mass Storage Device to locate your HP Personal Media 
Drive. USB Mass Storage Device may be listed twice. One may contain a 
memory card reader or other mass storage drive. 

4 Select the HP Personal Media Drive, and then click OK. The name of the 
drive may be different if you renamed it, or it may appear as Generic Volume 
followed by the assigned drive letter. 
A Safe to Remove Hardware message appears in the system tray, letting you 
know that the device is safe to disconnect. 

5 Click Close. 
6 Disconnect the drive by removing it from the drive bay. 
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Using Speakers 
Speakers are included with the monitor (select models only) or are sold separately. 
Your PC supports only an active (powered) speaker system; the speaker system 
must have its own power cable. 

NOTE: A stereo speaker set is a left-right, two-channel speaker system. A 
multichannel audio speaker system is a system with more than two channels, 
and it may include a subwoofer. For example, 7.1 channels, referred to as an 
eight-speaker mode, uses two front speakers (left-right), two side speakers 
(left-right), two rear speakers (left-right), a centre speaker and a subwoofer. 

The PC supports a variety of sound options and speaker configurations. You may 
set up your PC for two stereo speakers or for multichannel audio speaker systems. 
Connect your speaker system to the PC, and then configure the audio software for 
sound output. For details on connecting stereo speakers to the PC, see the quick 
setup poster. 

• If your PC model includes three sound connectors (select models only) on the 
back of the PC, see “Setting up 3-connector sound” on page 32. 

            
• If your PC model includes six sound connectors (select models only) on the back 

of the PC, see “Setting up 6-connector sound” on page 34. 

  

Working with Sound, 
Pictures and Video 

NOTE: If your PC 
includes a sound card 
(select models only), refer 
to the documentation 
that came with the 
sound card. 
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Setting up 3-connector sound 
PC models that include three sound connectors (select models only) on the back of 
the PC support up to six channels of sound (5.1 speaker output) and use the 
Multi-channel Sound Manager to configure the software settings. 

Connecting the speaker system to the PC (3-connector) 
The 3-connector audio speaker system uses the Audio In, Audio Out, and Mic 
connectors on the back or front of the PC. Refer to the quick setup poster for the 
location of the connectors. 

1 With the speaker system off, connect the speakers and the subwoofer, if 
present. Refer to the speaker documentation. 

2 Turn off the PC and the speakers. 
3 Connect the three audio cable plugs from the speaker system to the connectors 

on the back of the PC. (See the following table.) 
 

Connect speaker plugs for: 
 
2 Speaker 
Mode 

4/4.1 
Speaker 
Mode 

6/5.1 
Speaker 
Mode 

To PC 
connector 

Connector 
icon 

Front speakers Front speakers Front speakers Audio Out 
(lime-green)  

Not used for 
speakers 

Rear speakers Rear speakers Audio In 
(blue)  

Not used for 
speakers 

Not used for 
speakers 

Centre/ 
subwoofer 
speakers 

Mic-1 (pink) 
 

 

4 Turn on the PC. 
5 Turn on the speaker system. 
6 Configure the audio output for this 3-connector multichannel speaker system by 

performing the following procedure. 

Configuring the Multi-Channel Sound Manager 
(3-connector) 
1 Click Start on the taskbar. 
2 Choose All Programs. 
3 Click Multi-channel Sound Manager. The Multi-channel Audio 

Configuration window opens. 
 

NOTE: If you do not see the Speaker Configuration tab, your PC does not have 
the multichannel capability. However, it still has two-channel (stereo) output. 

 

4 Click the Speaker Configuration tab. 
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5 Select the option describing the number of speakers in your system, for 
example, 6/5.1 speaker mode. You can click the Speaker Test tab and 
then click a speaker icon to test it. 

6 Click OK. 
 

To use a microphone for recording, see “Using the microphone with the Multi-
Channel Sound Manager (3-connector)” on page 33. 

To hear all speakers from DVD movies recorded with multichannel audio, change 
the audio properties for WinDVD to match your speaker configuration (if your 
InterVideo WinDVD program supports more than two channels). Refer to 
“Configuring multichannel audio output for the DVD player” on page 33. 

Using the microphone with the Multi-Channel Sound 
Manager (3-connector) 
The 3-connector multichannel speaker system (select models only) connects to the 
PC using the Microphone, Audio (Line) In, and Audio (Line) Out connectors on the 
back of the PC. Your PC may have a second microphone connector on the front of 
the PC. If present, this microphone connector is ready to use, and does not affect 
the use of the multichannel audio speaker system. 

To use the microphone connector on the back of the PC with a 3-connector 
multichannel audio speaker system, you must disconnect the cables for the 
multichannel speakers and change the audio configuration to a two-channel audio 
system. Refer to “Configuring the Multi-Channel Sound Manager (3-connector)” on 
page 32 to set the audio configuration. 

Configuring multichannel audio output for the 
DVD player 
The InterVideo WinDVD™ SE program (select models only) is set up for 
two-speaker (stereo) output. To hear all speakers from DVD movies recorded with 
multichannel audio, change the audio properties for WinDVD to match your 
speaker configuration (if your InterVideo WinDVD program supports more than 
two channels): 

1 Insert a DVD, or start InterVideo WinDVD. (Click Start, choose All 
Programs, choose InterVideo WinDVD, select InterVideo WinDVD 
Player, and then click InterVideo WinDVD.) The WinDVD video window 
opens. 

2 Right-click anywhere in the WinDVD video window, and then click Setup. The 
Setup window opens. 

3 Click the Audio tab. 
4 Click the option for the number of speakers to match your multichannel speaker 

system. 
 

NOTE: When using the digital out connector for sound (6-connector, select 
models only), select Digital (S/PDIF) out to External Processor. 
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5 Click Apply. 

NOTE: To test the speakers (multichannel speakers only), click the Test button. 
The WinDVD control panel shows the speaker number being used. Click Stop. 

 

6 Click OK. 
 

NOTE: If you want to play a stereo DVD, change the audio properties of WinDVD 
to match the recorded DVD audio output. 

Setting up 6-connector sound 
PC models that include six sound connectors (select models only) on the back of 
the PC, support up to eight channels of sound (7.1 speaker output) and use the 
Sound Effect Manager to configure the software settings. 

Identifying the six audio connectors (6-connector) 
The PC supports a maximum of eight speakers in a multichannel speaker system 
by using four of the six audio connectors on the back of the PC. 

This PC also has digital audio out and digital audio in connectors for digital sound 
devices such as a DVD recorder or a digital stereo receiver/amplifier. 

The four connectors for the 6-connector 
multichannel speaker system are on the back of 
the PC: 

• A Side speaker port (side) 
• B Rear speaker port (rear) 
• C Centre speaker/subwoofer port (c/sub) 
• E Audio line out (out) for front speakers 

 

The previous figure shows the six audio 
connectors arranged on the back of the PC: the 
four connectors used for eight-channel audio 
and the connectors for the microphone (D, mic) 
and the audio line in (F, in). 
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Connecting the speaker system to the PC (6-connector) 
1 With the speaker system off, connect the speakers and the subwoofer, if 

present. Refer to the speaker documentation. 
2 Turn off the PC. 
3 Connect the audio cable plugs from the speaker system subwoofer to the 

connectors on the back of the PC. (See the following table.) 
 

Connect speaker cable 
(plug) for: To PC port [label, name] ( colour): 
Front speakers (or, two stereo 
speakers) 

Audio line out [E, out] (lime green) 

Side speakers Side speaker [A, side] (gray) 
Rear speakers Rear speaker [B, rear] (black)  
Centre speaker/subwoofer Centre speaker/subwoofer [C, c/sub] (gold) 

 

4 Turn on the PC. 
5 Turn on the speaker system. 
6 Configure the audio output for this 6-connector multichannel speaker system by 

performing the following procedure. 
 

Configuring the Sound Effect Manager (6-connector) 
1 Click Start on the taskbar. 
2 Choose Control Panel. 
3 If it is present, click Sounds, Speech, and Audio Devices. 
4 Click Sound Effect Manager. The window opens. 
5 Click the Speaker Configuration button. 
6 Select the option describing the number of speakers in your system, for 

example, 7.1 speakers. 
A connector with no descriptive text in the Connection Guide indicates that the 
connector is not used for the selected speaker configuration. 

 

NOTE: You can click the Speaker Test button to test the speakers. 
 

7 Click OK. 
 

To hear all speakers from DVD movies recorded with multichannel audio, change 
the audio properties for WinDVD to match your speaker configuration (if your 
InterVideo WinDVD program supports more than two channels). Refer to 
“Configuring multichannel audio output for the DVD player” on page 33. 

To set up the PC for recording, see “Configuring sound for recording with the 
Sound Effect Manager (6-connector)” on page 36. 

To use the Sound Effect Manager, see “Using the Sound Effect Manager 
(6-connector)” on page 37. 



 

36    Getting Started Guide 

Configuring sound for recording with the Sound Effect 
Manager (6-connector) 
The microphone connector on the front of the 6-connector audio PC is ready to use 
for recording sound. If you want to use another connector for recording, such as 
the digital audio in connector, use these steps to select it. 

NOTE: The pink and green connectors on the front of a PC with 6-connector 
sound can be retasked to perform other audio functions; refer to “Using the 
Audio Wizard in the Sound Effect Manager (6-connector)”on page 38. 

1 Click Start on the taskbar. 
2 Choose Control Panel. 
3 If it is present, click Sounds, Speech, and Audio Devices. 
4 Click Sounds and Audio Devices. 
5 Click the Audio tab. 
6 In Sound recording select the default device from the drop-down list. Choose: 

• RealTek HD Front Pink socket to use the microphone connector on the 
front of the PC. 

• RealTek HD Digital Input to use the digital audio in connector on the 
back of the PC. 

• RealTek HD Front Green socket to use the green connector on the front 
of the PC. 

• Back Line in/Mic, Front Line in to use the audio line in (in) or the 
microphone (mic) connectors on the back of the PC, or to use the audio line 
in connector on the front of the PC. 

 

NOTE: For this selection, the audio line in connector is ready to use. To use the 
back mic connector, follow the steps in “Selecting the Back Line in/Mic, Front 
Line in connectors for recording (6-connector)” that follows this procedure. 

 

7 Click Apply, and then click OK to close the window. 
 

Selecting the Back Line in/Mic, Front Line in connectors 
for recording (6-connector) 
Perform these steps when you select Back Line in/Mic, Front Line in for the sound 
recording in step 6 of the previous procedure. 

NOTE: If you want to record from the mic connector on the back of the PC, you 
must perform these steps. 

1 Click Start on the taskbar. 
2 Choose Control Panel. 
3 If it is present, click Sounds, Speech, and Audio Devices. 
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4 Click Sounds and Audio Devices. 
5 On the Volume tab, in the Device volume area, click the Advanced button. 

The Master Volume window opens. 
6 Click Options and choose Properties. 
7 In the Mixer devices area, select Back Line in/Mic, Front Line in from the 

drop-down list. Click OK. 
8 The recording control window opens and shows Line In 1 or 2 selected. The 

line in connector you plug into is used. However, to use the mic connector on 
the back of the PC, click the Select tick box under Microphone, so a tick 
appears in the box. 

 

Using the Sound Effect Manager (6-connector) 
The Sound Effect Manager has four buttons that display its control screens. 

To open the Sound Effect Manager: 

1 Click Start on the taskbar. 
2 Choose Control Panel. 
3 If it is present, click Sounds, Speech, and Audio Devices. 
4 Click Sound Effect Manager. The window opens. 
5 Click a button near the top of the window to see that control screen. 

 

The Sound Effect Manager control screens: 

• Sound Effect — selects the Environment and the Equaliser settings. You can 
select an Environment, such as Under Water or Auditorium. To use the 
Equaliser, click the power button in the centre of the circular equaliser control to 
turn on the Equaliser. You can click a pre-set button, such as Pop or Live, or 
manually adjust the settings, and then save them for easy selection later. 

• Speaker Configuration — selects the number of speakers, shows the 
Connection Guide, and has the Speaker Test button to test the speakers. A 
connector with no descriptive text in the Connector Guide indicates that the 
connector is not used for the selected speaker configuration. 

• Digital Audio — selects the digital audio output and digital audio frequency 
for the digital audio connectors on the PC. 

• Audio Wizard — opens a window that shows the connector panel on the 
front of the PC. To close the window without enabling the wizard, click OK. 

 

To enable the Audio Wizard: 
Make sure the Enable socket detection tick box is selected to enable the 
wizard. Click OK to close the window. 



 

38    Getting Started Guide 

 

Using the Audio Wizard in the Sound Effect Manager 
(6-connector) 
When you click the Audio Wizard button, a window opens that shows the three 
audio connectors on the front of the PC. 

 

NOTE: The connectors on the front of your PC may be of a different type or may 
be in a different arrangement; look for the connector icon and colour. 

 

Connector Name Icon Colour 

A Audio Line In 

 

Light blue 

B Microphone 

 

Pink 

C Headphones  
Or 
Audio Line Out    Or    

Lime green 

 

Retasking using the Audio Wizard (6-connector) 

With the Audio Wizard enabled, both the microphone connector (B) and the 
headphones connector (C) on the front of the PC can be retasked to perform a 
different audio function. These two connectors are universal audio sockets. When 
you plug in a cable, the wizard asks you to select the function for the cable from a 
list, and then it sets the universal audio socket to perform the selected function. The 
functions are: 

• Stereo speaker (out) 
• Microphone (in) 
• Headphone (out) 
• Audio line in 
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Working with Digital Images 
You can connect a digital image source, such as a digital camera or a digital 
video camera, directly to the PC or through a docking station. Digital picture files 
you copy or download from the device appear in the My Pictures folder. You can 
copy digital picture files from the memory cards used by digital cameras and other 
digital imaging devices by using the memory card reader (select models only). 
Refer to “Introducing the memory card reader” on page 39. 

Introducing the memory card reader 
Digital cameras and other digital imaging devices use memory cards, or media, to 
store digital picture files. The optional memory card reader (select models only) 
can read and write to a variety of types of memory cards and the IBM Microdrive 
disk drive. 

The card reader is accessible directly on the front of the PC or located inside a 
cover. It has four horizontal card slots, which accept the memory cards and the 
Microdrive disk drive. 

Card 4-slot reader 

CompactFlash™ Type I media Lower-left slot 

CompactFlash Type II media Lower-left slot 

IBM Microdrive disk drive Lower-left slot 

Secure Digital (SD) Memory Card Upper-right slot 

MultiMediaCard (MMC) Upper-right slot 

Memory Stick® (MS) Memory Card Lower-right slot 

Memory Stick (MS-Pro) Memory Card Lower-right slot 

SmartMedia™ (SM) Memory Card Upper-left slot 

xD media Upper-left slot 
 

You can place media in one or more of the card slots and use each media 
independently. Place only one piece of media in a slot at one time. 

Each card slot has its own drive letter and icon. When you insert media, the 
display label may change to the title of the media, if the title is present. 

Working with the Safely Remove Hardware utility 
 

 
CAUTION: Do not click Stop in the Safely Remove Hardware 
window with the USB Mass Storage Device selected. Doing so 
removes the operating system recognition of the memory card 
reader from your PC; you must restart the PC to see your memory 
card reader again. 

 

If you open the Safely Remove Hardware window by mistake, click Close. 
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Using the memory card reader 

NOTE: CompactFlash and Microdrive are keyed and cannot be inserted 
incorrectly. Insert the receptacle edge (holes) of this media into the slot. 

1 Insert the media into the card slot until it stops. The in-use light (A) on the card 
reader lights, and the PC automatically detects the media. 

2 The PC opens a window so you can use the media contents. You can copy files 
from or to the media. 

3 When you are finished, right-click the drive icon, select Eject, check that the 
in-use light is on but not blinking, and then remove the media. A steady light 
indicates that the PC is not reading or writing the media. 

 

 
WARNING: Do not try to remove media when the In-use light is 
blinking. Doing so may cause loss of data. 

 

Memory card reader 

 

 

Card Insert Into reader slot 

CompactFlash Type I media Receptacle edge (holes) C (lower-left) 

CompactFlash Type II media Receptacle edge (holes) C (lower-left) 

IBM Microdrive disk drive Receptacle edge (holes) C (lower-left) 

Secure Digital (SD) 
Memory Card 

Facing up D (upper-right) 

MultiMediaCard (MMC) Facing up D (upper-right) 

Memory Stick (MS) 
Memory Card 

Facing up E (lower-right) 

Memory Stick (MS-Pro) 
Memory Card 

Facing up E (lower-right) 

SmartMedia (SM) 
Memory Card 

Facing up B (upper-left) 

xD media Facing up B (upper-left) 
 

 
A In-use light 
B Upper-left slot 
C Lower-left slot 
D Upper-right slot 
E Lower-right slot 
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Using a TV as a Monitor 
Your PC may have TV-out (select models only) capability, which means you can 
connect it to a television to view the computer image on a TV screen. With the 
TV-out feature, you can view the computer image, watch DVD movies (if you have 
a DVD player), or play games on your TV. 

Identifying cables you may need 
To connect a TV to the PC, you may need a video cable and an audio cable 
(not provided; purchase separately). The type of video cable you need depends 
on your TV: 

• If your TV has an S-video socket, you need an S-video cable. 
• If your TV has a composite video socket, you need a composite video cable 

and, depending on the sockets on the back of your PC, you may also need an 
S-video adapter cable. 

 

Connecting to a TV set 
To use your TV as a PC screen: 

1 Turn off the PC. 
2 Connect the TV cable using one of the following arrangements, depending on 

the connection sockets on your TV: 
• If your TV has an S-video socket, connect an S-video cable from the S-video 

In socket on the TV to the S-video socket on the back of the PC. 

   

 

A S-video cable 
B Back of PC 
C S-video socket 
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• If your TV has a composite video socket and your PC has a composite video 
socket, connect a composite video cable to the Video In socket on the TV to 
the composite video socket on the back of the PC. 

   

• If your TV has a composite video socket and your PC has only an S-video 
socket, connect a composite video cable to the Video In socket on the TV 
and to an S-video adapter cable. Connect the S-video adapter cable to the 
S-video socket on the back of the PC. 

   

NOTE: The S-video adapter cable is only needed if there is no composite video 
socket on the back of the PC. 

 

3 To have sound come from your TV instead of from your PC, plug an audio 
cable into the audio input socket (Audio Line In) on the TV and plug the other 
end of the audio cable into the Audio Out socket (green connector) on the back 
of the PC. 

 

Viewing the PC image on your TV screen 

NOTE: The type of video card on your PC determines how the PC selects the 
TV-out option. Some options and menus in this procedure may be different for 
your PC. 

1 Make sure the video and audio cables are connected before you turn on the TV 
and the PC. 

2 Turn on the TV. Press the Video/TV button on your remote control to select the 
Video setting, not the TV setting. 

 
A Composite video 

cable 
B Back of PC 
C Composite video 

socket 

 
A Composite video 

cable 
B S-video adapter cable 
C Back of PC 
D S-video socket 
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3 Turn on your PC. 
4 When the Windows desktop appears, right-click an empty area of the desktop 

and choose Properties. The Display Properties window opens. 
5 Click the Settings tab. 
6 Click the Advanced button. 
7 Look at the tabs and follow the steps that apply to your PC: 

• If you see the nView tab, continue with “nView tab.” 
• If you see the Ge Force FX xxxx tab, continue with “Ge Force tab.” (FX xxxx 

is the video card number.) 
• If you see the Displays tab, continue with “Displays tab.” 

nView tab 
 

1 Click the nView tab. 
2 To view the computer image on your PC monitor and your TV simultaneously, in 

the area nView Display Mode select Clone. 
Or 
To view the PC image on just the TV, in the area nView Display Mode, select 
Standard [Dualview], click the Device Settings button, choose Select 
Output Device, and then select the TV option. 

3 Click the OK button. 
4 When the PC image appears on the TV screen, click Yes to keep the setting. 

You have 15 seconds to accept this new setting before it reverts to the previous 
setting. 

5 Click the OK button to save changes, and then click OK again to close the 
Display Properties window. 

Ge Force tab 
 

1 Click the Ge Force FX xxxx tab. 
2 To view the computer image on your PC monitor and your TV simultaneously, in 

the area nView Modes select Clone from the drop-down list. 
Or 
To view the PC image on just the TV, in the area nView Modes select Single 
display from the drop-down list, and then, if necessary, in the Current display 
area select TV from the drop-down list. 

3 Click the Apply button. 
4 When the PC image appears on the TV screen, click Yes to keep the setting. 

You have 15 seconds to accept this new setting before it reverts to the previous 
setting. 

5 Click the OK button to save changes, and then click OK again to close the 
Display Properties window. 
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Displays tab 
1 Click the Displays tab. This tab shows a monitor and a TV. The upper-left 

corner of each display icon is a button and a status indicator. A red corner 
indicates an inactive display; a green corner indicates an active display. 

NOTE: Your TV must be connected to the PC to change the display. 

2 To view the computer image on your PC monitor and your TV simultaneously, 
click the upper-left corner of the TV icon so that it is green. Click Apply. 
Or 
To view the PC image on just the TV, click the TV corner so it is green, and then 
click the monitor corner so it is red. Click Apply. 

3 When the PC image appears on the TV screen, click Yes to keep the setting. 
You have 15 seconds to accept this new setting before it reverts to the previous 
setting. 

4 Click the OK button to save changes, and then click OK again to close the 
Display Properties window. 

 

NOTE: Some PC models can connect more than one display device (CRT monitor, 
flat panel monitor, TV, and so on) to the PC. You can quickly change where the 
PC desktop appears by pressing Alt+F5. (Press the Alt key and the F5 key on the 
keyboard at the same time.) Each time you press the Alt+F5 key combination, the 
PC desktop appears on the next device. If Alt+F5 does not work, restart the PC 
and try again. 

 

Disabling the TV option 
When you want to disconnect the TV from your PC, you may need to disable the 
TV option to return your PC display to its original resolution. 

1 Right-click an empty area of the screen, and choose Properties. The Display 
Properties window opens. 

2 Click the Settings tab. 
3 Click the Advanced button. 
4 Look at the tabs and follow the steps that apply to your PC: 

• If you see the nView tab, continue with “nView tab (disabling).” 
• If you see the Ge Force FX xxxx tab, continue with “Ge Force tab 

(disabling).” 
• If you see the Displays tab, continue with “Displays tab (disabling).” 
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nView tab (disabling) 
1 Click the nView tab. 
2 If you viewed the computer image on your PC monitor and your TV 

simultaneously, click the nView Display Mode in the list on the left, and then 
select the Standard [Dualview] option. 
Or 
If you viewed the PC image on just the TV, click the nView Display Mode in 
the list on the left, select Standard [Dualview], click the Device Settings 
button, choose Select Output Device, and then select the Analogue 
Display option. 

3 Click the OK button. 
4 When the PC image appears on the monitor screen, click Yes to keep the 

setting. You have 15 seconds to accept this new setting before it reverts to the 
previous setting. 

5 Click the OK button to save changes, and then click OK again to close the 
Display Properties window. 

 

Ge Force tab (disabling) 
1 Click the Ge Force FX xxxx tab. 
2 In the area nView Modes select Single Display from the drop-down list. In the 

area Current display select Analogue Display or Digital Display. 
3 Click the Apply button. 
4 When the PC image appears on the monitor screen, click Yes to keep the 

setting. You have 15 seconds to accept this new setting before it reverts to the 
previous setting. 

5 Click the OK button to save changes, and then click OK again to close the 
Display Properties window. 

 

Displays tab (disabling) 
1 Click the Displays tab. This tab shows a monitor and a TV. The upper-left 

corner of each display icon is a button and a status indicator. A red corner 
indicates an inactive display; a green corner indicates an active display. 

2 Click the upper-left corner of the TV icon so it is red, and then click the upper-
left corner of the monitor icon so it is green. Click the Apply button. 

3 When the PC image appears on the monitor screen, click Yes to keep the 
setting. You have 15 seconds to accept this new setting before it reverts to the 
previous setting. 

4 Click the OK button to save changes, and then click OK again to close the 
Display Properties window. 
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Disconnecting the TV 
1 Disable the TV option. See the previous procedure. 
2 Turn off the TV and the PC. 
3 Remove the video cable from the TV and the PC. 
4 Remove the audio cable from the TV and the PC. 
5 Reconnect your PC speaker cable to the Line Out socket (lime green connector) 

on the back of the computer. 
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Your PC includes software that lets you play music CDs and DVD movies (select 
models only). This section describes how to: 

• Play music CDs using Windows Media Player, or play music CDs or DVDs 
with iTunes. 

• Play DVD movies using Windows Media Player or InterVideo WinDVD Player 
(select models only). 

• Play video CDs (VCD) with InterVideo WinDVD or Windows Media Player. 
 

Playing Music CDs with iTunes 
You must have either a CD or DVD drive. 

1 Insert the music CD into your CD or DVD drive. 
• The iTunes window opens. If the Audio CD wizard window opens, choose 

Play Audio CD using iTunes from the list. You may have to scroll down 
in the window to see iTunes. 

Or 
• If the iTunes window does not automatically open, click Start on the taskbar, 

choose All Programs, click iTunes, and then click iTunes. 
2 The music CD automatically begins to play. 
Or 

Click the play button in the upper-left corner of the iTunes window. To 
play a particular song, double-click the song name (or track number). 

NOTE: If you do not have an Internet connection, your CD is listed as Audio CD 
on the source list and your Song Names are listed as Track numbers. 

For more information on using iTunes, click the Help menu in the iTunes menu 
bar. Go to http://www.hp.com/music for help online. 

Playing CDs and DVDs 
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Playing CDs and DVDs with Windows 
Media Player 
Your PC must have a DVD drive to play DVD movies. 

1 Insert the music CD or DVD movie into the drive: 
• The Windows Media Player window opens. If the wizard window opens, 

select Windows Media Player from the list. You may have to scroll down 
in the window to see Windows Media Player. 

Or 
• If the Windows Media Player window does not automatically open, click 

Start on the taskbar, choose All Programs, and then click Windows 
Media Player. 

 

2 To play the CD or DVD, use the playback buttons in the Windows Media Player 
window. To play a particular track, double-click the title (or track number) in the 
Playlist. You can also control playback by using the media control buttons on 
the keyboard (select models). 

For more information on using Windows Media Player, click the Help menu in 
the Windows Media Player menu bar. If necessary, first display the menu bar by 
clicking the up-arrow icon in the upper-left corner of the Windows Media Player 
window. 

Playing DVD Movies with 
InterVideo WinDVD 
The InterVideo WinDVD program uses a DVD drive (select models only) to play 
DVD movies. 

NOTE: Most DVD movies are localised to geographical countries/regions. See 
“Using country/region codes” on page 50. 

1 Insert a DVD disc into the DVD drive. 
 

NOTE: On a double-sided DVD, read the text around the inner hole of the 
disc to determine which side (A versus B or Standard versus Widescreen) to 
play. Place the disc in the tray with the label facing up for the side you want 
to play. 

 

2 Close the disc tray by gently pushing the tray into the PC. 
The movie plays in its own resizable video window, and the WinDVD control 
panel appears. If the Play DVD movie wizard window opens, select Play DVD 
movie using InterVideo WinDVD from the list. You may have to scroll 
down in the window to see it. 
Or 
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If the program does not automatically open: 
a Click Start, choose All Programs, choose InterVideo WinDVD, select 

InterVideo WinDVD Player, and then click InterVideo WinDVD. 
b Use the playback buttons on the control panel to view the movie. 

 

NOTE: To see what a button does on the control panel, place the mouse 
pointer on the button; the button title appears onscreen. 

 

NOTE: If you are playing a movie full screen and the WinDVD control panel 
is hidden, you can redisplay it by clicking anywhere in the video window. 

 

To use the WinDVD control panel: 

• To move the WinDVD control panel, place the mouse pointer on the panel (but 
not on a button), and drag it to the desired location on the screen. 

• To resize the video window when it is not full screen, place the mouse pointer 
on a window corner, and drag the border. 
Or 
Click the Full Screen button in the upper-right corner of the WinDVD 
control panel. 

• For information on the InterVideo WinDVD software, refer to the online 
Help within the program by clicking the ? (question mark) icon in the WinDVD 
control panel. 
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Using country/region codes 
Most DVD discs have country/region codes embedded in the disc data that limit 
where the DVD movie can be played. 

The country/region number is usually placed over a world globe printed on the 
DVD packaging and disc. DVDs without country/region codes will play on any 
player or drive in any country/region. 

 

WARNING: You can change countries/regions only five times before 
the country/region code locks and becomes permanent. Once the 
code locks, you can play DVDs from that country/region only. If the 
country/region code locks, and you need help, contact Support. 

 

WinDVD is not pre-set to a particular country/region — the country/region code 
of the first DVD movie you play determines your DVD country/region. 

For example, if you play a DVD with a country/region 1 code, WinDVD sets the 
current country/region of your DVD player to 1. If you later play a DVD that is 
coded for a different country/region, WinDVD asks if you want to set this as the 
current country/region. 

Playing Video CDs (VCD) with 
InterVideo WinDVD 
1 Insert your Video CD (VCD) into a DVD or CD drive. 
2 Select Play DVD movie using InterVideo WinDVD, and click OK. 

Or 
If the program doesn’t open, click Start, choose All Programs, choose 
InterVideo WinDVD, select InterVideo WinDVD Player, and then 
click InterVideo WinDVD. 

3 If you have a dual-language Video CD, the sound of one language comes out 
of the left speaker, and the other language comes out of the right speaker. 
Double-click the Volume icon on the taskbar. 

4 Under Volume Control Balance, move the slider bar all the 
way to the right or to the left, depending on which language you 
want to hear. 

5 Close the Volume Control window. 
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Playing Video CDs (VCD) with Windows 
Media Player 9 
1 Insert your Video CD (VCD) into a DVD or CD drive. 
2 Select Play DVD movie using Windows Media Player, and click OK. 

Or 
If the program doesn’t open, click Start, choose All Programs and 
Windows Media Player. 

3 Click File on the menu bar at the top, and click Open. (If you do not see the 
menu bar, click the small circle with the up/down arrows in the upper-left 
corner of the window.) 

4 Click the Look In drop-down arrow and select the drive that has the 
Video CD. 

5 Double-click the MPEGAV folder. 
6 Select Any File (*.*) from the Files of type drop-down list. 
7 Select the file, and click Open. 
8 If you have a dual-language Video CD, the sound of one language comes out 

of the left speaker and the other language comes out of the right speaker. Click 
View on the menu bar, choose Enhancements, and select Graphic 
Equaliser. 

9 Move the Balance slider bar all the way to the left or to the right, depending 
on which language you want to hear. 

10 Close the Graphic Equalizer window. 
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NOTE: Burn is an industry term used to describe the recording of information onto 
a DVD or CD. Optical recording uses a laser beam to place information onto the 
disc, thus the term burning. 

 

NOTE: If your recording fails, manually select a slower recording speed, if 
available, each time you make a recording. Refer to the Help menu in your 
selected software program for more information about selecting a slower 
recording speed. 

 

NOTE: HP supports lawful use of technology and does not endorse or encourage 
the use of our products for purposes other than those permitted by copyright law. 

If your PC has a CD-RW or DVD Writer drive (select models only), your PC has 
recording software and you can make your own music or data CDs. 

Your PC has four recording software programs, iTunes, Windows Media Player, 
RecordNow!™, and Windows XP. You copy or download music to their library 
and can then organise or copy the music files. You can copy Windows Media 
files that have a .wma extension, .mp3 files or .wav files to a CD by using a 
CD-RW drive or a DVD Writer drive. You can also use iTunes or Windows Media 
Player to copy music files to a portable device or memory card. 

Use a CD-R disc if you are going to play the disc in a CD player, CD-ROM, 
CD-RW, DVD-ROM, DVD+RW/+R or double-layer DVD+R drive. CD-R discs are 
compatible with more players than CD-RW discs. 

Creating (Burning) CDs and DVDs 
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Creating (Burning) Music CDs with iTunes 
To create a music CD using iTunes: 

1 Click Start on the taskbar, choose All Programs, select iTunes, and then 
click iTunes. 

2 Click the Edit menu and select Preferences. 
3 Click the Burning tab and choose Audio CD as the Disc Format. 
4 Click the Use Sound Check check box if you would like all songs on the 

CD to play at the same volume level, and click OK. 
5 Click the File pull-down menu, and select New Playlist. 
6 Enter a name for your new playlist, and an empty playlist window opens. 
7 Drag and drop selected songs from your source to your new playlist. 
8 Click the Burn Disc button in the upper-right corner. 
9 Insert a blank disc into your drive (double-layer DVD+R discs are not 

compatible). 
10 Click OK. 
For more information on using iTunes, click the Help menu in the iTunes menu 
bar. Go to http://www.hp.com/music for help online. 

Creating (Burning) Music CDs with 
Windows Media Player 
1 Click Start on the taskbar, choose All Programs, and then click 

Windows Media Player. 
2 Click Copy to CD or Device. 
3 Click the drop down arrow in the Items to Copy field, and select the songs 

you want to burn to a CD. 
If there are not any songs listed, insert a CD into your drive and click Copy 
from CD. Follow the onscreen instructions. 

4 Click the Copy button in the upper-right corner. 
 

For more information on using Windows Media Player, click the Help menu in 
the Windows Media Player menu bar. If necessary, first display the menu bar by 
clicking the up-arrow icon in the upper-left corner of the Windows Media Player 
window. 
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Creating (Burning) Data CDs Using 
Windows XP 
Your PC has recording software to record data files, such as text files or digital 
pictures, onto CDs. 

1 Click Start on the taskbar and choose My Documents or the folder that has 
the files you want to copy. 

2 Select the file or files you want to copy. 
3 Click Copy to CD in the Tasks list. 
4 Click My Computer in the Other Places list and then double-click the disc 

drive you want to use. 
5 Insert a blank disc into the drive. 
6 Click Write these files to CD in the CD Writing Tasks list. The CD Writing 

Wizard window appears. 
7 Click Next. 
8 Click Finish. 

 

Creating (Burning) CDs with RecordNow! 

NOTE: For more information about recording CDs, refer to the Help menu in the 
Sonic RecordNow! software program. 

 

NOTE: The CD-RW, DVD Writer or Double-Layer drive is available on select 
models only. 

1 Click Start on the taskbar. 
2 Choose All Programs. 
3 Click Sonic RecordNow!, and then click RecordNow! again. 

NOTE: Previously recorded files on CD-RW discs must be erased before 
recording music files. CD-R discs cannot be erased. 

4 If you need to erase a disc (CD-RW or DVD+RW): Insert the disc, and select the 
Home Screen Tab, and then select Erase Disc. 
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Creating Music CDs with RecordNow! 
RecordNow! creates closed session music CDs, which means you must record all 
music files on one CD in one recording session. Music files can be recorded 
repeatedly on a rewritable CD-RW disc, but all previously recorded files must be 
erased first. CD-R discs cannot be erased. 

NOTE: CD-R discs play in most home and car stereos. CD-RW discs play only in 
some stereos. 

 

IMPORTANT: HP supports the lawful use of technology and does not endorse or 
encourage the use of our products for purposes other than those permitted by 
copyright law. 

You can use RecordNow! to create audio CDs to play in your car or home CD 
player or on your PC. 

Creating CDs to Play in Your Car or Home 
CD Players with RecordNow! 
1 Click Start, choose All Programs, Sonic RecordNow!, and then click 

RecordNow!. 
2 Select the Audio Projects tab. 
3 Select Audio CD for Car or Home CD Player. 
4 Insert a music CD to view the tracks on your CD. Select 

View if you would like to look at another optical drive. 
Or 
Click Find and then click either Scan for Music or Browse to find music 
files on your hard disk drive that you want to record. 

5 Select the tracks you want to record, and then click Add. 

NOTE: Press and hold Control (Ctrl) on your keyboard to select more than one 
track. 

6 Click the Burn icon when you have added all the audio files to 
your music CD project. 

7 Click Yes. 
8 When prompted, insert a blank CD-R or CD-RW disc. 
9 Click OK. It is best not to use the PC while recording. 

10 Click Done when recording is complete. 
 

Click the Help icon and then select RecordNow! Help for more information 
about recording music CDs with the RecordNow! program. 



 

Creating (Burning) CDs and DVDs    57 

 

Creating CDs to Play on Your PC 
1 Click Start, choose All Programs, Sonic RecordNow!, and then click 

RecordNow!. 
2 Click the Audio Projects tab. 
3 Select Jukebox CD. 
4 Insert a music CD to view the tracks on your CD. 

Or 
Click Find and then click either Scan for Music or Browse to find music 
files on your hard disk drive that you want to record. 

 

NOTE: RecordNow! scans for all audio files, even the sounds from 
your operating system. If you don’t want to display some of these 
sounds, you can select the Options icon (wrench), and then 
select Audio. Select Hide audio files shorter than (in 
seconds), type in the number of seconds, and click OK. 

 

5 Select the tracks you want to record, and then click Add. 

NOTE: Press and hold the Control (Ctrl) key to select more than one track. 

6 Click the Burn icon when you have added all the audio files to your 
music CD project. 

7 Click Yes. 
8 When prompted, insert a blank CD-R or CD-RW disc. If the CD-RW disc is not 

blank, RecordNow! prompts you to erase it and then automatically begins 
writing to it when it is erased. 

NOTE: If you want to play your music CD in your home or car stereo, use a 
CD-R disc. CD-RW discs may not play in some stereos. 

9 Click OK. It is best not to use the PC while recording. 
10 Click Done when recording is complete. 

 

Click the Help icon and then select RecordNow! Help for more information 
about recording music CDs with the RecordNow! program. 

Creating a Music CD 

IMPORTANT: HP supports the lawful use of technology and does not endorse or 
encourage the use of our products for purposes other than those permitted by 
copyright law. 
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When recording music files, it is important to note that: 

• To play your music CD in a home or car stereo, it needs to be recorded as a 
music CD in CD Audio (CDA) format, not as a data CD. 

• You must record all music files in one recording session because RecordNow! 
closes the CD after recording is complete. Music files can be recorded 
repeatedly onto a rewritable (CD-RW) disc, but all previously recorded music 
files must be erased first. 

• As you add music files in the recording session, RecordNow! calculates and 
displays the amount of recording time available to record additional music files. 

• You can’t record song titles unless you make an exact copy of a music CD in 
your collection. 

• If you try to record more than a standard CD can hold, RecordNow! displays a 
message warning you that all the tracks may not fit on your disc. 

 

Storing Files on a DVD or CD 
Unlike music CDs, data DVDs and CDs can be recorded in multiple sessions. 

1 Click Start, choose All Programs, Sonic RecordNow!, and then click 
RecordNow!. 

2 Select the Data Projects tab. 
3 Insert a blank or appendable CD-R, CD-RW, DVD+R, 

DVD+RW or Double-Layer DVD+R (select models) disc into 
your drive, and then click Data Disc. 
• If the disc is blank, follow the onscreen instructions. 
Or 
• If the disc is full, insert a blank or another appendable disc. 
Or 
• If you are adding files to a disc, follow the onscreen instructions. 

NOTE: An appendable disc means additional files can be added to it, if there 
is disc space available. Recorded audio CDs are closed session discs which 
are not appendable. 

4 To name your disc, select Volume Label, and then type a name over it. 
RecordNow! assigns a name based on the recording date if you don’t type in 
a name. 

5 Add your data files to the file selection window: 
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• Click the Add Files and Folders button, find and select your folders and 
files, and then click Add. Repeat this step until all files are added. 

   

Or 
• Drag your file from your desktop or from anywhere in Windows Explorer 

into the file selection window. Repeat this step until all files are added. 

NOTE: You can rename your files in the file selection window by selecting and 
typing over the current name. This does not affect the original files on your hard 
disk drive. 

6 Click the Burn icon when all of your files have been added. 
7 Click Done when recording is complete. 

 

Click the Help icon and then click RecordNow! Help for more information 
about recording data files with the RecordNow! program. 

Storing Data Files on Disc 
When storing data files on a disc, it is important to note that: 

• You can add new data files to a CD-R and a DVD+R in a later 
recording session, until the disc is full. With DVD+R discs, you need to 
select the correct setting in RecordNow! to record files in a later 
session. To do this, insert your recorded DVD, open RecordNow!, click the 
Options icon (wrench), click Data, select the recording option you want, and 
then click OK. 

• When you record files that have the same name as previously recorded files, 
RecordNow! updates the file and the previous version is overwritten. 

• RecordNow! allows you to change file names and titles of files you want to 
record and names of files that were previously recorded. 

• As you select data files to record to your disc, RecordNow! calculates and 
displays the amount of recording space used on your disc. 
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Copying a DVD or CD 

IMPORTANT: HP supports the lawful use of technology and does not endorse or 
encourage the use of our products for purposes other than those permitted by 
copyright law. 

RecordNow! allows you to make a copy of a music or data disc from your 
collection. You can’t copy commercial DVDs because they are protected by 
copyright laws and are encoded to prevent illegal duplication. 

To make a copy of a music or data disc from your collection: 

1 Click Start, choose All Programs, Sonic RecordNow!, and then click 
RecordNow!. 

2 Select the Data Projects tab. 
3 Select Exact Copy. 
4 Insert the CD or DVD you want to copy. 
5 Click the Copy icon. 
6 Insert a blank DVD or CD into the drive, and then click OK. 
7 Click Done when the recording is complete. 

 

Erasing a DVD or CD 
You can use RecordNow! to erase music, data, or video files from rewritable 
DVDs and CDs, leaving almost all the disc space available for new recordings. 

If you try to record a video or music file to a rewritable disc that has files on it, the 
recording program prompts you to erase the disc first. 

1 Click Start, choose All Programs, Sonic RecordNow!, and then click 
RecordNow!. 

2 Insert the DVD+RW or CD-RW you want to erase. If an Auto Play window 
opens, click Cancel. 

3 Select the Home Screen tab and then Erase Disc. 
4 Click Yes to confirm that you want to erase the disc. 
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Removing Files in RecordNow! 
When removing files in RecordNow!, it is important to note: 

• When you remove a recorded file from a data DVD+R or CD-R, the disc space 
is lost and can’t be used for new recordings. 

• You can’t remove music files from previously recorded music CDs, but you can 
remove music files from the File Selection window in RecordNow! before you 
record the files to your disc. 

• You must use a blank CD to create a music CD. 
• If you delete files from the File Selection window in RecordNow! before the disc 

is recorded, available disc space is not affected. If you remove a file from a 
DVD+R or CD-R after the disc is recorded, available disc space is lost. 

 

Removing Files from a Recorded Data Disc 
RecordNow! can’t erase files from recordable (record once) DVDs or CDs, but 
files that have been previously recorded can be removed. When you remove a 
recorded file from a data DVD+R or CD-R, the disc space is lost and can’t be used 
for new recordings. 

To remove data files from a recorded DVD or CD: 

1 Click Start, choose All Programs, Sonic RecordNow!, and then click 
RecordNow!. 

2 Select the Data Projects tab. 
3 Insert the disc from which you want to remove files. If an Auto 

Play window opens, click Cancel. 
4 Click Data Disc. 
5 You must have at least one file on your data disc to re-record it. Select 

the file you want to remove and then click the Remove icon in the 
upper-right corner. 

6 Click Yes. 
7 Click the Burn icon to save your data disc without the files you 

removed. 
8 Click Done when the recording is complete. 

 

Archiving Files on a DVD or CD 
1 Click Start, choose All Programs, Sonic RecordNow!, and then click 

RecordNow!. 
2 Select the Backup Projects tab. 
3 Select File Archive. 
4 Insert a blank CD or DVD into the drive. 
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5 Place a tick in the Changed since box to limit the scan to files that have been 
changed since the last time you completed a File Archive. 

6 Add your files to the Archive window: 
• Select one or more categories from the list on the left, and click Scan. 

RecordNow! scans your hard disk for files related to the category, and 
moves them to the Archive window on the right. 

• Drag files from the Windows Explorer to the Archive window. 
7 Click the Burn icon when all of your files have been added. 

If the files do not fit on one disc, File Archive asks you for additional 
discs. 

8 Click Done when recording is complete. 
 

Creating an Image File 
RecordNow! can take all the files from a CD or DVD, and convert it into a single 
file called an image file. You can use the image file to reproduce the original disc. 
This is often used when you need to make multiple copies of the same disc. 

Saving an Image 
1 Click Start, choose All Programs, Sonic RecordNow!, and then click 

RecordNow!. 
2 Select the Backup Projects tab. 
3 Select Save Image. 
4 Insert the source disc into the drive. 
5 Click Browse to set the destination and name of the image file. 
6 Click the Save icon to create the image file. 

 

Burning an Image 
1 Click Start, choose All Programs, Sonic RecordNow!, and then click 

RecordNow!. 
2 Select the Backup Projects tab. 
3 Select Burn Image. 
4 Click the Browse button to locate your saved image file. 
5 Click the Burn icon. 
6 Insert a blank CD or DVD into the drive. 
7 Click Done when recording is complete. 
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Recording Video Files 
Video quality depends on the quality of the source files, the PC speed, and its 
graphics processing ability. Refer to the “Recording VHS Video Files Direct to 
DVD” section on page 78 of this guide. 

NOTE: Your DVD Writer or CD Writer drive will not copy commercially available 
DVD movies. Most commercial DVDs are encoded to prevent unauthorised 
duplication. 

Using Disc Labels 
 

 

WARNING: When labelling your DVDs, do not use sticky labels. They 
can cause the DVD to play erratically. Instead, write on the DVD 
with a felt tip pen to label it. 

 

Creating Recovery CDs/DVDs for the PC 
For more information about creating Recovery CDs/DVDs, refer to the Warranty 
and Support Guide that came with your PC. 

Setting Automatic Recording Options 
When you first insert a blank CD 
into your DVD Writer or CD 
Writer drive, Microsoft® 
Windows® XP may give you 
options for the type of disc you 
insert. 

NOTE: When you insert a blank 
DVD into your DVD Writer/CD 
Writer drive, an options window 
does not appear. You must open 
the program you want to use with 
your DVD, and then perform an 
action. 

For example, if you insert a blank 
CD-RW disc, you see options 
such as: 

• Open writeable CD folder using Windows Explorer. 
• Create a disc using RecordNow!. 
• Take no action. 
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The options displayed depend on what software is on the PC. 

You can choose to have a specific action occur automatically each time you insert 
a blank CD by selecting the Always do the selected action box. 

If you later decide that you want to change the option you have set: 

1 Click Start. 
2 Click My Computer. 
3 Right-click the DVD Writer/CD Writer drive icon (may be labelled 

DVD/CD-RW) and select Properties. 
4 Click the AutoPlay tab. 
5 Click Select an action to perform, select an action, and then click OK. 

Or 
Click Prompt me each time to choose an action, and then click OK. 

 

If this window of options does not appear, you can click Start, My Computer, 
right-click the DVD Writer/CD Writer drive icon (may be labelled 
DVD/CD-RW), and then select one of the available options. 

You can also open a program before you insert a disc. After the program is 
opened, select an action and follow the onscreen instructions within the program. 

If the option you want is not listed, you can select Take no action, and then 
click OK. The window closes, and you can then manually select a different option 
through the Start menu on the desktop. 

Here are some of the other options you can choose to view the files on the disc 
you inserted: 

• Click Start, My Computer, and then right-click the DVD Writer/ 
CD Writer drive icon, and choose Explore. 

• Click Start, My Computer, and then double-click the DVD Writer/ 
CD Writer drive icon. 

Using Compatibility Information 
An important feature of a DVD Writer/CD Writer drive is its high level of 
compatibility with other optical drives and CD and DVD players. 

• The CDs that you create play in most home and car stereos, and in most 
computer DVD-ROM and CD-ROM drives. 

NOTE: CD-R discs are more compatible with home and car stereos than CD-RW 
discs. 

• The DVDs that you create are compatible with some DVD video players, and 
with most computer DVD-ROM drives. 

 

Your DVD Writer/CD Writer drive is able to read from and record to almost every 
type of optical disc. Writing speed rates for the DVD Writer/CD Writer drive are 
fast, allowing quick recording times. 
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Identifying Compatible File Formats 
Your DVD Writer/CD Writer drive can read and record the following audio 
formats: 

• WAV, MP3, WMA and CDA for CDs 
• WAV, MPEG-1, MPEG-2, WMA and Layer 2 files for DVDs 

 

Your DVD Writer/CD Writer drive can read and record the following video 
formats: 

• MPEG-1 and MPEG-2 
• AVI and WMV 

 

Using the Disc Quick Reference Tables 
You can use DVD+RW, DVD+R, CD-RW and CD-R discs in the DVD Writer/ 
CD Writer drive. 

Using double-layer DVD+R discs 
• Can only be written to with a Double-Layer DVD drive (select models only). 
• Can’t be erased or written to again. 
• Holds up to 8.5 GB — the equivalent of 12 CDs. 
• Records up to 4 hours of video files, depending on the quality of the recording. 
• Can be used to back up your hard disk drive files. 

Using DVD+R discs 
• Can’t be erased or written to again. Some programs, like RecordNow!, allow 

you to record data in multiple sessions until the disc is full. 
• Can’t edit a DVD+R that has been recorded as a DVD movie. 
• Holds up to 4.7 GB — the equivalent of seven CDs. 
• Records up to 2 hours of video files, depending on the quality of the recording. 
• Compatible with more DVD drives and players than a DVD+RW disc is. 
• Can be used to back up your hard disk drive files. 
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Using DVD+RW discs 
• Can be erased and rewritten. 
• Can hold up to 4.7 GB — equivalent of seven CDs. 
• Records up to 2 hours of video files, depending on the quality of the recording. 
• Can be used to back up hard disk drive files that you can update periodically. 

Using CD-R discs 
• Can’t be erased or written to again. Some programs, like RecordNow!, allow 

you to record data in multiple sessions until the disc is full. 
• Can hold about 80 minutes of music files, or up to 99 tracks. 
• Can hold 700 MB of data, depending on the CD. 
• Can be used to create storage discs for your hard disk drive files. 

Using CD-RW discs 
• Can be erased or rewritten. 
• Can hold about 80 minutes of music files, or up to 99 tracks. 
• Can hold 700 MB of data, depending on the CD. 
• Can be used to create storage discs for your hard disk drive files. 

 

Video recording length 
Video quality setting  

Disc type Good Better Best 
8.5 GB Double-Layer DVD+R 325 minutes 217 minutes 108 minutes 
4.7 GB DVD+RW, DVD+R 180 minutes 120 minutes 60 minutes 
700 MB CD-RW, CD-R 27 minutes 18 minutes 9 minutes 
650 MB CD-RW, CD-R 24 minutes 16 minutes 8 minutes 

 

NOTE: CD-R discs are more compatible with home and car stereos than 
CD-RW discs. 
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Disc feature and compatibility 

 
Disc 

 
File type 

Can be 
recorded 
onto 

 
Plays 
in PC 

Plays in 
home or 
car stereo 

Plays in home 
DVD player 

Data No Yes No No CD-ROM 
Music No Yes Yes Varies by model 
Data Yes Yes No No CD-R  
MP3 Music Yes Yes Varies by 

model 
Varies by model 

Data Yes Yes No No CD-RW 
MP3 Music Yes Yes Varies by 

model 
Varies by model 

Data No Yes No No DVD-
ROM DVD movie No Yes No Yes 

Data Yes Yes No No DVD+R 
DVD movie Yes Yes No Varies by model 
Data Yes Varies 

by 
model 

No Varies by model Double-
Layer 
DVD+R 

DVD movie Yes Varies 
by 
model 

No Varies by model 

Data Yes Yes No No DVD+RW
DVD movie Yes Yes No Varies by model 

VCD DVD movie No Yes No Varies by model 
 

NOTE: This PC comes with the Double-Layer DVD-Writer drive. It supports 
single-layer and double-layer DVD media. Double-Layer technology gives you 
greater capacity, and allows you to store up to 8.5 GB* of data on double-layer 
DVD+R media. 

Double-Layer is a new technology. The Double-Layer media created may not work 
with some home DVD players and computer DVD-ROM drives. 

*GB is defined as 1 billion bytes 

For the latest disc compatibility information for your PC, check the following Web 
site: http://www.hp.com 
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Optical drive quick reference 
 
Optical 
drive can 

 
CD-ROM 

 
CD-RW 

 
DVD-ROM 

 
DVD+RW/+R 

 
Double-
Layer 

Combo  
CD-RW/ 
DVD 

Read CDs, 
CD-Rs, 
and 
CD-RWs 

X X X X X X 

Read 
DVDs   X X X X 

Read data 
on a CD X X X X X X 

Play music X X X X X X 
Record 
data or 
music to 
disc for 
storage or 
backup 

 X  X X X 

View DVD 
movies   X X X X 

Record 
DVD 
movies 

   X X  

Play PC 
games X X X X X X 

 

Using the Software Quick Reference Table 
To open the DVD Writer/CD Writer software programs, click Start on the 
taskbar, choose All Programs, select the program folder, and then click the 
program to open the software. Refer to the following table to determine the best 
programs for the tasks you want to do. 

NOTE: You may have a software update CD included with your PC. You may 
need to install this CD before using the DVD Writer/CD Writer drive. To do this, 
follow the installation instructions that came with the CD. 

Your PC comes with the following software programs. Use this table to find out 
what you can do within each program. 

NOTE: Some programs listed below may not be included with your PC model. 
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Software With this program you can 
iTunes 

 

• Play music CDs, MP3 and other audio files. 
• Record music files. 
• Record a copy of an existing music or data 

CD to use on the PC. 
• Organise digital files into a library for 

recording or listening. 
Windows Media Player 

 

• Play music CDs, MP3, and other audio 
files. 

• Play DVD movies. (Windows Media Player 
can play DVDs only if another DVD player 
program, such as InterVideo WinDVD, is 
installed.) 

• Play Windows Movie Maker files. 
• Record music files. 
•  Organise digital files into a library for 

recording or listening. 
RealOne Player 

 

• Play music CDs, MP3 and other audio files. 
• Play DVD movies. (RealOne Player can 

play DVDs only if another DVD player 
program, such as InterVideo WinDVD, is 
installed.) 

• Play video CDs. 
• Record music files. 
• Organise digital files into a library for 

recording or listening. 
Windows  
Movie Maker 2.0 

 

• Import audio, video, and other media files 
from a videotape, an audiotape, a Web 
camera, or a television broadcast. 

• Record audio and video files to create a 
video project that becomes a Windows 
Media source file with a .wmv extension. 

• Edit and preview files. 
• Send movie in an e-mail or to a Web 

server. 
• Add music files (MP3). 
• Import audio files such as .mp3, .asf or 

.wma; video files such as .wmv, .asf, .avi 
or .mpg; or image files such as .jpg or .gif. 

• Can create AVI and WMV (Windows 
Media Video) files. 
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Software With this program you can 
InterVideo WinDVD 

 

• Play DVD movies and video CDs (VCD). 

RecordNow! 

 

• Record data and music files. 
• Record a copy of an existing music or data 

CD to use on the PC. 
• Create customised music CDs from CDs in 

your collection, or from WAV, MP3 or 
WMA files. These CDs can be played in 
your home or car stereo. 

• Copy and share data files. 
• Copy short video files. 
NOTE: Video files recorded with RecordNow! 
can be viewed on a PC but not on home DVD 
video players. 

InterVideo WinDVD Creator 

 

• Capture digital and analogue video files 
directly from a digital video (DV) camera, 
VCR or other analogue capture device. 
NOTE: Your PC may not include an 
analogue capture device. 

• Assemble movies by capturing video clips 
and scenes into a video project. 

• Edit your movies. Cut scenes, add music 
and sound effects, still images, text, video 
transitions and voice-overs. 

• Preview movies during editing and before 
recording final files. 

• Create video files, export them to your hard 
disk drive or your digital video camera, 
and then play them on your PC. 

• Create video files, record them to DVDs 
and CDs, and then play them on some set-
top DVD players. 

• Record video files to seven different 
formats. 
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Your PC allows you to capture (copy), edit, and record your home movies in four 
easy steps by using the InterVideo WinDVD Creator® software program (select 
models only). 

Capture: Take videos and pictures from digital camcorders, analogue video 
devices, and Webcams, and then save them to your hard disk drive. 

Edit: Arrange and trim your files. Add titles, transition effects, images, and audio. 

Add Menu: Add a menu with chapters to your DVD. 

Make Movie: Finalise your project by burning your movie to a DVD. 

For more information on WinDVD Creator, click the Help menu in the 
WinDVD Creator menu bar. 

Getting Started 
1 Click Start, choose All Programs, InterVideo WinDVD, InterVideo 

WinDVD Creator, and then click InterVideo WinDVD Creator again. 
2 Select one of the menu options: 

• Capture video into hard disk: Opens the Capture section for you to 
capture media. 

• Create CD/DVD with existing video file: Brings up the Open window 
for you to select existing video files. 

• Record video tape into DVD disc in one step: Enables you to 
bypass the hard disk and record straight from your camera to a disc in 
your DVD drive. 

• Open existing project: Brings up the Open window for you to select an 
existing project. 

• Create new project: Opens the Edit section for you to begin creating a 
new project. 

 

Creating DVD Movies 
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Using the Preview Window 
The Preview window is located in the upper-left corner. It behaves differently for 
each task. 

Capture: Displays what your capture device is viewing. 

Edit: Plays back the selected video or displays the selected image. 

Add Menu: Displays what your menu and buttons look like. 

Using the Media Library 
The Media Library contains your video clips, images, and audio tracks. To import 
existing media files from your hard disk or CDs into your Media Library, click the 
Drag and Drop button. 

Capture: Located in bottom right corner. Contains your video clips, images 
and audio tracks. 

Edit: Located in upper-right corner. Contains your video clips, images and 
audio tracks. 

Add Menu: Located in upper-right corner. Contains menu themes, video 
backgrounds, audio tracks, images, buttons, chapter layouts and chapter 
thumbnails. 

Using the Storyboard 
The Storyboard is located on the bottom of the Edit and Add Menu area. The 
Storyboard can be displayed in either Menu Picker or Timeline Mode. Use the 
Storyboard to organise your media, and add special effects such as titles, 
transition effects, audio tracks and video filters. 

Identifying Requirements for 
Capturing Video 
You can copy (capture) video files to your hard disk drive by using the WinDVD 
Creator program. Among the devices supported by WinDVD Creator are 
analogue video devices, digital camcorders and Web cameras. Use composite or 
S-Video inputs to capture video from a VCR, or an analogue video camera. 

To capture video files, you need to: 

• Connect your video source device properly. 
• Turn your device on and set it to playback mode. 
• Make sure the program you want to use can detect your digital or 

analogue device. In the WinDVD Creator capture screen, click your input 
source, click the wrench icon, select the Device Control tab, and select your 
source from the Video Source drop-down menu. 
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NOTE: You may need to turn your device off and on again for the program to 
detect it. 

 

If your PC has multiple video devices connected, they all appear on the Capture 
screen. Select the video source you would like to use. 

Capturing Digital Camcorder Video 
1 Click Start, choose All Programs, InterVideo WinDVD, InterVideo 

WinDVD Creator, and then click InterVideo WinDVD Creator again. 
2 Click the Capture video into hard disk button. 
3 Connect your digital camcorder to your PC. 
4 Make sure the output from your digital camcorder appears in the Preview 

window. If it does not, double-check your connections, and make sure your 
camera is in Playback mode. 

5 Click the Play button to preview your video file before you record it. 
6 Find your starting point in the video and click the Pause button. 
7 Click the Record button. 
8 Enter a file name, click Save, and recording begins. 
9 Click the Stop button to stop capturing your video file. Your video file is 

processed and automatically saved to the My Videos folder on your hard disk 
drive. The video clip appears in the Media Library portion of the screen. 

10 To play back your captured video, click the file in the Media Library and click 
the Play button in the Preview window. 

Capturing Web Camera Video 
1 Click Start, choose All Programs, InterVideo WinDVD, InterVideo 

WinDVD Creator, and then click InterVideo WinDVD Creator again. 
2 Click the Capture video into hard disk button. 
3 Connect your Web camera to your PC. 
4 Make sure the output from your Web camera appears in the Preview window. If 

it does not, double-check your connections. 
5 Click the Record button. 
6 Enter a file name, click Save, and recording begins. 
7 Click the Stop button to stop capturing your video file. Your video file is 

processed and automatically saved to the My Videos folder on your hard disk 
drive. The video clip appears in the Media Library portion of the screen. 

8 To play back your captured video, click the file in the Media Library and click 
the Play button in the Preview window. 
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Capturing Analogue Video 
1 Click Start, choose All Programs, InterVideo WinDVD, InterVideo 

WinDVD Creator, and then click InterVideo WinDVD Creator again. 
2 Click the Capture video into hard disk button. 
3 Connect your VCR, television or other input device to your composite or 

S-Video inputs. 
4 Click your input source, click the wrench icon, and select the Device 

Control tab. 
5 Select your composite or S-Video source in the Video Source drop-down 

menu. Click OK. 
6 Click the Record button. 
7 Enter a file name, click Save, and recording begins. 
8 Click the Stop button to stop capturing your video file. Your video file is 

processed and automatically saved to the My Videos folder on your hard disk 
drive. The video clip appears in the Media Library portion of the screen. 

9 To play back your captured video, click the file in the Media Library, and click 
the Play button in the Preview window. 

 

Capturing a Still Image 
1 Pause your input device on the position for which you would like an image. 
2 Click the Capture Still Image button under the Preview 

window. 
3 The image is saved to the My Pictures folder on your hard disk 

drive. 

Editing Video Files in WinDVD Creator 
After you capture video files, use the WinDVD Creator Edit module to create your 
customised video file. In the edit mode you can add: 

• Video files 
• Still images 
• Audio and music tracks 
• Transition effects 
• Title effects 
• Video Filters 
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To edit your video files: 

1 If your project is already open, click the Edit button and skip to step 4. 
2 Click Start, choose All Programs, InterVideo WinDVD, InterVideo 

WinDVD Creator, and then click InterVideo WinDVD Creator again. 
3 Open a project by either selecting the Create new project or Open 

existing project button. 
4 If you have already captured video for this project, drag and drop the video 

files from the Media Library to the Storyboard. If you have video files on your 
hard disk drive which you would like to add to this project, click the Drag and 
Drop button. 

5 If you do not like the sequence of the video files, drag and drop the files in the 
storyboard to change the sequence. 

Adding Images 
1 Click the Image Library icon. 
2 Click the Drag and Drop button to open the My Pictures folder on 

your hard disk drive. 
3 Select the images from your hard disk which you would like to add to your 

Image Library and click Open. 
4 Drag and drop images from the Image Library to your storyboard. 
Click the following icons to edit still images and video files. 

Storyboard Icons 
Group Groups multiple images into one on the storyboard. 
Expand Expands grouped images so they are all displayed on the 

storyboard. 
Save Movie Records output directly to a DV camcorder. Or writes output to 

a file in your selected format. 
Edit Clip Trims a video clip: 

1 Double-click a video clip on the Storyboard. 
2 Adjust the sliders to cut off video at the beginning or 

the end. 
Merge Clip Merges current clip with the next clip. 
Split Clip Splits a video clip: 

3 Click the video clip which you want to split. 
4 Click the Play button in the Preview window. 
5 Click the Split Clip icon at the point of the clip which you to 

want split. 
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Adding Audio Effects 
1 Click the Audio Library icon. 
2 Click the Drag and Drop button to open the My Music folder on your 

hard disk drive. 
3 Select the audio files from your hard disk which you want to add to 

your audio library, and click Open. 
4 Drag and drop the audio files from the Audio Library to the video file of 

your choice. 
5 A musical note icon appears in the bottom right corner of the video file to 

which the audio track was assigned. 
6 To keep the audio track running for more than one video file, switch from 

storyboard mode to timeline mode. Drag the music track across more than 
one video file. 

Adding Transition Effects 
1 Click the Transition Effects icon. 
2 Drag and drop a transition effect between the two video files where 

you would like the effect to appear. 

  

Adding Title Effects 
1 Click the Title Effects icon. 
2 Drag and drop a title effect either in between video files or to a video 

file on the storyboard. 
3 Type the text which you would like to appear on your title screen. 
4 If you inserted the title effect in between video clips, click on the Image 

Setting icon to adjust the length of time where you want the title clip to 
appear. 

A capital T appears in the bottom right corner of the title clip on the storyboard. 
 

Adding Video Filters 
1 Click the Video Filters icon. 
2 Drag and drop a video filter to the video of your choice. 
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Adding a Menu 
The Add Menu section turns your project interactive. It creates a menu theme and 
breaks your project into chapters. The menu theme can be your own images and 
music, or a custom theme that comes with WinDVD Creator. 

1 If your project is already open, click the Add Menu button. 
2 Click Start, choose All Programs, InterVideo WinDVD, InterVideo 

WinDVD Creator, and then click InterVideo WinDVD Creator again. 
3 Select the Open existing project button, and select your project. 
4 Click the Add Menu button. 
5 Click the media library icons to add a menu theme, chapters, buttons, audio 

tracks and images to your DVD. 
6 Click the storyboard icons to edit the chapters and menu items. 

Making a Movie 
This is the final step of your DVD project. You select a format, the type of TV 
system, and volume name. 

1 If your project is already open, click the Make Movie button and skip to 
step 5. 
Click Start, choose All Programs, InterVideo WinDVD, InterVideo 
WinDVD Creator, and then click InterVideo WinDVD Creator again. 

2 Select the Open existing project button, and select your project. 
3 Click the Make Movie button. 
4 Insert a blank recordable DVD or CD into your drive. 
5 Choose one from each of the following sections (order of selections may differ): 

 

Burn to Disc Select where you would like the file to be recorded: 
• Burn to Disc: Use this to burn directly to a DVD or CD. 

• Write content to hard disk for later burning: Use this 
to create the file on your hard disk drive. 

Select Device Select the device that contains the blank recordable DVD or CD. 

Burning 
Speed 

Select the speed to use when recording your project. 

Format Select one of the formats to record your project. 

TV System Select between NTSC and PAL for your TV system. The NTSC 
format is used in North America, and the PAL format is used in 
European and Asian countries/regions. 

Volume 
Name 
of Disc 

Enter a Volume name for your disc (optional). 

 

6 Click Start. 
7 Click OK. 
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Recording VHS Video Files Direct to DVD 
To record VHS video files direct to DVDs: 

1 Connect your VCR or other analogue video source to your composite or 
S-Video input. 

2 Click Start, choose All Programs, InterVideo WinDVD, InterVideo 
WinDVD Creator, and then click InterVideo WinDVD Creator again. 

3 Select the Record video tape into DVD disc in one step button. 
4 Insert a blank DVD into your drive. 
5 Click the Capture button, and select your VCR. 
6 Press the Playback button on your VCR. 
7 Click the Record button when the preview window displays what you want to 

record. 

Converting Recorded TV to MPEG-2 
Format (Europe only) 
1 If your project is already open, click the Edit button and skip to step 4. 
2 Click Start, choose All Programs, InterVideo WinDVD, InterVideo 

WinDVD Creator, and then click InterVideo WinDVD Creator again. 
3 Open a project by either selecting the Create new project or Open 

existing project button. 
4 Click the Save Movie icon and select Output to File. 
5 Select a GQ, HQ, SP, LP or EP format, and click OK. 
6 Enter a file name and click Save. 



 

Troubleshooting    79 

For help on general and miscellaneous problems which you may be experiencing 
with your PC, refer to the following pages for possible solutions. For more detailed 
information, press the Help button on your keyboard, or click Start on the 
taskbar, and select Help and Support. 

To find help for problems with your PC, see the table in this section that describes 
the symptom, problem, and solution for your situation. Look up the description of 
the symptom or problem, and try the solution listed. The tables appear in this 
order: 

• Audio 
• CD-ROM, CD-RW, DVD-ROM or DVD Writer Drive 
• Diskette (Floppy) Drive 
• Display (Monitor) 
• Hard Disk Drive 
• Hardware Installation 
• Internet Access 
• Keyboard and Mouse 
• Memory 
• Miscellaneous 
• Power 

 

Some of the symptoms listed may not apply to your PC. For problems relating 
specifically to the monitor or printer, refer to the equipment documentation. 

Troubleshooting 

Symptom describes 
the sign or warning 
message for the type of 
problem. 

Problem identifies one 
or more reasons why the 
symptom may have 
occurred. 

Solution describes 
what you should do to 
try to solve the problem. 
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Audio 
Symptom Problem Solution 

Volume is muted. Press the Mute button on the keyboard to see if the mute 
feature is turned on. 
Or 
1 Click Start, and then click Control Panel. 
2 Click Sounds, Speech, and Audio Devices, if it is 

present, and then double-click Sounds and Audio 
Devices. 

3 Click the Mute tick box to remove the tick from the box. 

Volume is turned down. Use the keyboard controls to increase the volume. 

Speakers are turned off. Check whether speakers are turned on. 

Speaker cables are not properly 
connected. 

Turn off your PC, and reconnect the speakers. 

PC is in standby mode. Press the Standby button (select models only) or press the 
Esc key on the keyboard to resume from standby mode. 

A passive speaker system is 
being used. 

Replace the speaker system with an active speaker system. 
Active speakers have a power cable and On button, and 
connect to the Audio Out (green) connector on the PC. 

No sound is 
produced. 

Headphones are plugged in. Unplug the headphones. 
 

CD-ROM, CD-RW, DVD-ROM, or DVD Writer Drive 
Symptom Problem Solution 

Disc is upside down in the 
drive tray. 

Reinsert the disc with the label facing up. 

DVD drive takes longer to start 
because it has to determine 
media type being played. 

Wait at least 30 seconds to let the DVD drive determine the 
type of media. If it still does not start, read the other 
solutions listed in this topic. 

Disc is dirty. Clean the disc with a CD cleaning kit, available from most 
PC stores. 

CD-ROM, CD-RW, 
DVD-ROM or 
DVD+RW/+R drive 
cannot read a disc or 
takes too long to start. 

Windows does not detect 
CD-ROM or DVD-ROM driver. 

Driver program may be corrupted. Force the software to 
reinstall it by doing the following: 
1 Click Start, and then click Control Panel. 
2 Click Performance and Maintenance, if it is 

present, and then double-click System. 
3 Click the Hardware tab, and then click the Device 

Manager button. 
4 Click the plus sign (+) next to the DVD/CD-ROM drives, 

and select the problem drive. 
5 Click the Action menu item, and select Uninstall. 

Click OK. 
6 Restart your PC: Click Start, click Turn Off Computer, 

and then click Restart. 
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CD-ROM, CD-RW, DVD-ROM, or DVD Writer Drive (continued) 
Symptom Problem Solution 

Cannot remove a CD or 
DVD disc. 

The PC is turned off. Turn on your PC and press the Eject button to extend 
the tray. 

Problem with disc. • Make sure the label is face up and centered in the tray. 
• Verify that you are using the correct disc type (media) for 

the drive. Try a different brand of disc. 
• Make sure the disc is clean and undamaged. If 

recording stopped during a recording session, the disc 
may be damaged; use a different disc. 

• Use the correct type of disc for the type of files you are 
recording. When using a CD-R disc, make sure it is 
blank when recording music, and is blank or 
appendable (disc with space to add more data files) 
when recording data. 

• Verify that you are using the correct disk when making a 
copy of a disc. RecordNow! can record only to the same 
disc type as the source. For example, you can record a 
DVD only to a DVD+R or a DVD+RW disc, and you can 
record a CD only to a CD-R or a CD-RW disc. 

Problem with drive. • Make sure the disc is in the correct drive. 
• Make sure you select the correct drive before recording. 

RecordNow! selects the first optical drive it finds, but you 
can select the drive in RecordNow! before you begin 
recording. 

• Make sure the recording disc tray is clean and 
undamaged. 

• Select a slower write speed for the recording drive, if it 
is available. Each time you make a recording, 
RecordNow! selects the optimum recording speed. Refer 
to the Help menu in the RecordNow! recording program 
to choose the speed. 

Cannot create (burn) 
a disc. 

Problem with PC operation. • RecordNow! does not let you add a track if it exceeds 
the available space on your disc. You can make space 
available by removing one or more tracks from the list 
before recording the files to disc. 

• Close all software programs and windows before 
recording. 

• Make sure you have enough space available on your 
hard disk drive to store a temporary copy of the content. 

• If you are on a network, copy the files from a network 
drive to your hard disk drive first, and then record them 
to disc. 

• Enable Direct Memory Access (DMA) on your PC. 
• Restart the PC and try again. 
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CD-ROM, CD-RW, DVD-ROM, or DVD Writer Drive (continued) 
Symptom Problem Solution 

Cannot add files to my 
music CD. 

RecordNow! creates a 
closed session music CD. 

When recording a music CD, RecordNow! does not allow 
recording of additional files after the initial recording. 

Cannot add data to 
my DVD. 

Wrong recording option 
being used. 

Make sure you set the correct recording option: Insert your 
data disc, open RecordNow!, click the Options icon 
(wrench), click Data, select the multiple session recording 
options, and then click OK. 

Problem with disc. • Use a CD-R, not a CD-RW disc. 
• Try a different brand of disc, or check to see if the brand 

of disc works with your stereo. Refer to the 
documentation that came with your stereo or player and 
check the manufacturer’s Web site. 

• Use a CD instead of a DVD. Audio files on a DVD can 
be played on your PC, but you cannot create a music 
DVD to be played in a home CD player. 

Cannot play my music CD 
in my stereo. 

Problem with file type. Convert MP3 or WMA audio files to WAV or CDA music 
files before recording. 

Titles of music tracks do not 
appear on my CD. 

Not connected to Internet.  The PC must be connected to the Internet for the artist, title, 
and track information to appear when playing your music 
CD in Windows Media Player, or when recording your 
music CD with RecordNow! 
Note that RecordNow! does not record the information 
to disc. 

An error message appears 
when I try to capture 
video. 

Video capture device not 
selected. 

You may need to select the capture device if your PC has 
both an analogue and a digital video capture device. Refer 
to the Help menu in the video capturing program to find out 
how to change the video device selection. 

Movie recorded using 
wrong file format. 

Your DVD player cannot play video files recorded onto the 
DVD as data files. To play a movie properly, use a video 
recording program such as WinDVD. 

Cannot play my DVD 
movie on my DVD player. 

Problem with recording 
method. 

Video files recorded with RecordNow! can be viewed on a 
PC but not on a home DVD video player. 
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Diskette (Floppy) Drive (Select Models Only) 
Symptom Problem Solution 

A non-formatted diskette has 
been inserted. 

To format the diskette: 
1 Click Start, and then click My Computer. 
2 Right-click the 3½ Floppy (A:) icon. 
3 Select Format. 
4 Select the desired options, and click Start to begin 

formatting the diskette. 

Diskette is damaged. Use a new diskette. 

PC is unable to read 
the diskette (floppy 
disk). 

Diskette drive has failed. Press the Help ? button on the keyboard to open the Help and 
Support Center, or refer to the Warranty and Support Guide to 
contact Support for replacement details. 

Diskette is improperly 
inserted. 

Remove the diskette, and reinsert it: Insert the diskette with the 
round metal disk facing down and the arrow on the top pointing 
into the drive, and then push the diskette in until it stops. 

Diskette drive activity 
light stays on. 

Diskette drive is damaged. Press the Help ? button on the keyboard to open the Help and 
Support Center, or refer to the Warranty and Support Guide to 
contact Support for replacement details. 

Diskette is full or the file is 
too big. 

Use another diskette or compress the file to reduce its size. 

Diskette is write-protected. Slide the write-protection tab to the unlocked position on the 
diskette. 

File Save command was not 
properly executed. 

When saving information to the diskette drive, verify that you 
are using the correct drive letter. 

Diskette is damaged. Replace the diskette. 

Diskette drive cannot 
save (write) 
information to the 
diskette. 

Diskette is not formatted. To format the diskette: 
1 Click Start, and then click My Computer. 
2 Right-click the 3½ Floppy (A:) icon. 
3 Select Format. 
4 Select the desired options, and click Start to begin 

formatting the diskette. 
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Display (Monitor) 

NOTE: If you encounter display (monitor) problems, refer to the documentation that came with your monitor and 
to the common causes and solutions listed in this table. 

 

Symptom Problem Solution 

Monitor power cable is not 
connected to the monitor or 
to the wall socket. 

Reconnect the power plug on the back of the monitor and 
on the wall socket. 

Screen is blank, and 
monitor power light 
is not lit. 

Monitor is off (not 
turned on). 

Press the On button on the front of the monitor. 

Screen saver is enabled. Press any key or move the mouse to make the screen 
display visible again. 

PC is in standby mode. Press the Standby button (select models only) or press the 
Esc key on the keyboard to resume from standby mode. 

PC is in hibernation mode or 
is off. 

Press the On button to turn on the PC. 

Screen is blank. 

Monitor connector cable is 
not properly connected to 
the back of the PC. 

Inspect the monitor video connector for bent pins. If no pins 
are bent, reconnect the monitor connector cable on the 
back of the PC. 

Images on the screen are 
too large or too small, or 
the images are fuzzy. 

The screen resolution setting 
may not be set to your liking 
or may not be the best for 
your monitor. 

Adjust the monitor resolution setting in Windows. See your 
monitor documentation for the best resolution for your 
monitor. 

 

Hard Disk Drive 
Symptom Problem Solution 

PC seems to be locked up 
and not responding. 

Program in use has stopped 
responding to commands. 

Use the Windows Task Manager to close any programs not 
responding or to Restart the PC: 
1 Press the Ctrl, Alt and Delete keys on the keyboard at the 

same time. 
2 Select the program that is not responding, and click 

End Task. 
Or 
Click Shut Down, and then click Restart. 

If this does not work, press the On button for 5 or more 
seconds to turn off the PC. Then, press the On button. 

Hard disk drive error 
message displays. 

Part of hard disk drive has 
failed or is about to fail. 

Press the Help ? button on the keyboard to open the Help 
and Support Center, or refer to the Warranty and Support 
Guide to contact Support for replacement details. 
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Hardware Installation 
Symptom Problem Solution 

Device driver is not 
installed. 

Install the device driver from the CD or diskette provided 
with the device, or download and install the driver from the 
device manufacturer’s Web site. 

You may need an updated driver for Windows XP. Contact 
the device vendor directly for an update. 

For HP peripherals, visit the HP Web site. 

Device connector is not 
seated or connected 
properly. 

Ensure that the device is properly and securely connected 
and that the pins in the connector are not bent down. 

Cable(s) of new external 
device are loose, or power 
cables are unplugged. 

Ensure that all cables are properly and securely connected, 
and that the pins in the cable or connector are not bent. 

Power switch of new device 
is not turned on. 

Turn off the PC, turn on the external device, and then turn 
on the PC to integrate the device with the PC system. 

When the system advised 
you of changes to the 
configuration, you did not 
accept them. 

Restart the PC, and follow the instructions for accepting the 
changes. 

A new device is not 
recognised as part of 
the system. 

A Plug and Play card may 
not automatically configure 
when added, if the default 
configuration conflicts with 
other devices. 

Deselect the automatic settings in the operating system for 
the card, and choose a basic configuration that doesn’t 
cause a resource conflict. 

You can also reconfigure or disable devices to resolve the 
resource conflict. 

New device does 
not work. 

Cannot install new device 
driver. 

You must be logged in as the computer administrator to 
install or uninstall a device driver. To switch users, click 
Start, click Log Off, and then click Switch User; choose 
the computer administrator user. (The computer 
administrator is usually the user Owner.) 
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Hardware Installation (continued) 
Symptom Problem Solution 

New or existing device 
does not work after 
installing a new device. 

A hardware device conflict 
exists. 

To resolve a device conflict, you may need to disable one of 
the devices, or uninstall an old device driver: 
3 Click Start and click Control Panel. 
4 Click Performance and Maintenance, if it is 

present. 
5 Double-click the System icon, and select the 

Hardware tab. 
6 Click the Device Manager button. 
7 Click the + (plus) symbol next to the problem device 

and check for exclamation marks in a yellow circle near 
the device icon. The exclamation mark means there is a 
device conflict or problem with the device. Exclamation 
marks do not always appear when a device is not 
working properly. 

8 If there is an old or unnecessary device driver listed in 
the Device Manager, this may be causing the device 
conflict. To uninstall the old driver for the new device 
driver to work properly, do the following: Right-click the 
device, click Uninstall, and then click OK. 

9 Right-click the device, and select Properties. 
10 If available, click the Resources tab to verify that there 

is a device conflict. 
11 Click the General tab to see if your device is enabled 

and working properly. If it is available, click the 
Troubleshoot button, and follow the onscreen 
instructions in the device troubleshooter wizard. 

12 Restart the PC. Click Start, click Turn Off Computer, 
and then click Restart. 
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Internet Access 
Symptom Problem Solution 

Internet Service Provider 
(ISP) account is not set up 
properly. 

Verify Internet settings, or contact your ISP for assistance. 

Modem is not set up 
properly. 

Reconnect the modem, verifying connections. 

Note that your PC may also have an Ethernet network 
interface (also called a network interface card, or NIC) that 
connects to a LAN (local area network). Although it looks 
similar to the modem connector, the RJ-45 Ethernet network 
connector is not the same. Verify that you are using the 
modem connector. Do not connect a telephone cable to the 
NIC. Do not plug a network cable into a telephone service 
line; doing so may damage the NIC. 

Cannot connect to the 
Internet. 

Web browser is not set up 
properly. 

Verify that the Web browser is installed and set up to work 
with your ISP. 

Cannot automatically start 
Internet programs. 

You must log in to your ISP 
before some programs will 
start. 

Log in to your ISP, and start the desired program. 

Internet takes too long to 
download Web sites. 

Modem is not set up 
properly. 

Verify that the correct modem speed and COM port are 
selected: 
1 Click Start, and then click Control Panel. 
2 Click Printers and Other Hardware, if it is present. 
3 Double-click Phone and Modem Options. 
4 Select the Modems tab, and then click the Properties 

button. 
5 In the Device status area, verify the modem is working 

properly. 
6 In the Device usage area, verify the modem is enabled. 
7 If there are further problems, click the Troubleshoot 

button, and follow the onscreen instructions. 

The AOL program comes 
up even when it is not 
being used. 

The PC is still trying to use 
AOL for Internet access. 

You may want to remove the AOL program. 
To uninstall AOL: 
1 Click Start on the taskbar. 
2 Click Control Panel. 
3 Double-click Add or Remove Programs. 
4 Select America Online, click Change/Remove, and 

then follow the onscreen instructions. 
NOTE: Removing the AOL program will not cancel your 
account with AOL. 
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Keyboard and Mouse 
Symptom Problem Solution 

Keyboard connector is not 
properly connected. 

Turn off the PC by using the mouse, reconnect the keyboard 
to the back of your PC, and turn on your PC. 

Program in use has stopped 
responding to commands. 

Restart or turn off your PC using the mouse. 

Keyboard commands and 
typing are not recognised 
by the PC. 

Keyboard is damaged. Press the Help ? button on the keyboard to open the Help 
and Support Center, or refer to the Warranty and Support 
Guide to contact Support for replacement details. 

Cursor will not move using 
the arrow keys on the 
keypad. 

The Num Lock key may 
be on. 

Press the Num Lock key. The Num Lock light should not be 
on if you want to use the arrow keys in the number keys 
group. 

The keyboard Print button 
does not work. 

Some programs do not 
recognise the Print button. 

Use the Print menu item in the program. 

Wireless keyboard does 
not work after installation 
or is not detected. 

Keyboard batteries are low 
or empty. 

Replace the two AA alkaline batteries in the wireless 
keyboard; then set the ID channel by pressing the Connect 
button on the wireless receiver, and then on the keyboard. 
Refer to the documentation that came with your wireless set. 

Mouse connector is not 
properly plugged into the 
back of the PC. 

Turn off your PC using the keyboard: 
1 Press the Ctrl and Esc keys on the keyboard at the same 

time to display the Start menu. 
2 Use the Up arrow or Down arrow key to select Turn Off 

Computer, and then press the Enter key on the 
keyboard. 

3 Use the Up arrow or Down arrow key to select Turn 
Off, and then press the Enter key. 

After the shutdown is complete, plug the mouse connector 
into the back of your PC and turn on your PC. 

Program in use has stopped 
responding to commands. 

Restart your PC by using the keyboard. If possible, save any 
open files, and close open applications before restarting. 

Mouse does not 
respond to movement 
or is too slow. 

Surface in use for a 
roller-ball type mouse is too 
smooth. 

Use a mouse pad or other rough surface for the mouse. 

Mouse roller ball is dirty. Remove roller ball cover from bottom of mouse and clean 
the ball with a damp, lint-free cloth (not paper). 

Mouse moves only 
vertically or horizontally. 

Mouse is damaged. Press the Help ? button on the keyboard to open the Help 
and Support Center, or refer to the Warranty and Support 
Guide to contact Support for replacement details. 

Mouse is not connected 
properly. 

Try unplugging and then reconnecting the mouse cable to 
your PC. 

Mouse does not work after 
installation or is not 
detected. Wireless mouse batteries 

are low or empty. 
Replace the two AA alkaline batteries in the mouse; then set 
the ID channel by pressing the Connect button on the 
wireless receiver, and then on the mouse. Refer to the 
documentation that came with your wireless set. 
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Keyboard and Mouse (continued) 
Symptom Problem Solution 

The optical sensor uses the 
pattern of the surface to 
track the position of the 
cursor. Reflective surfaces, 
grooved surfaces, glass, or 
other see-through surfaces 
inhibit the ability of the 
sensor to track the cursor. 

Place the mouse on a mouse pad or white sheet of paper. Optical mouse does not 
track cursor well. 

Mouse sensor is dirty. Wipe the light sensor lens on the bottom of the mouse with 
a lint-free cloth (not paper). 

Mouse cursor moves 
too fast. 

The wireless mouse moves 
the cursor more quickly than 
a standard mouse. 

Adjust the mouse speed in Windows. 

 

Memory 
Symptom Problem Solution 

Insufficient memory 
message is displayed. 

All memory in the PC is 
being used by open 
programs, and memory is 
needed for a desired task. 

Close all open programs, and then try desired task again. 

Or 

Restart your PC: 

1 Click the Start button. 

2 Click Turn Off Computer. 

3 Select Restart. 
 

Miscellaneous 
Symptom Problem Solution 

PC date and time display 
is incorrect. 

RTC (real-time clock) battery 
may need to be replaced. 
Battery life is approximately 
3–5 years. 

First, reset the date and time in your operating system by 
using the Control Panel. If the problem persists, replace the 
battery. See the Upgrading and Servicing Guide for 
instructions, or refer to the Warranty and Support Guide to 
contact Support for replacement details. 

Printer has problems.  Printer will not print correctly 
or at all. 

If you encounter printer problems, refer to the 
documentation that came with your printer. 

 



 

90    Getting Started Guide 

Power 
Symptom Problem Solution 

PC is not securely connected to 
an external power source. 

Ensure that cables connecting the PC to the external power 
source are plugged in properly. 

Green power supply light on 
back of PC is out. 

When the cables connecting the PC to the external power 
source are plugged in properly and the wall socket is 
functioning, the green power supply light should be on; if the 
light is not on, refer to the Warranty and Support Guide to 
contact Support. 

Monitor is not connected or is 
not on. 

Connect the monitor to the PC, plug it in, and turn it on. 

Line voltage selection switch is 
not in the proper position for 
your country/region 
(115V∿/230V∿). 

Set the line voltage selection switch to the correct setting for 
your country/region, or refer to the Warranty and Support 
Guide to contact Support. 

Wall socket is defective. Test the socket by connecting a different electrical device to 
the socket. 

Wrong memory modules were 
used in an upgrade, or memory 
modules were installed in the 
wrong location. 

Reinstall the old memory to return your PC to its original state. 
Refer to the Upgrading and Servicing Guide for instructions. 

Hard disk drive is damaged. Press the Help ? button on the keyboard to open the Help and 
Support Center, or refer to the Warranty and Support Guide 
to contact Support for replacement details. 

PC will not turn on 
or start. 

After an upgrade or repair, the 
drive power, data, or power 
supply cables may not be 
properly connected. 

Reseat drive power, data, and power supply cables. See the 
Upgrading and Servicing Guide for instructions. 

Invalid system disk  
Or 
Non-System disk or 
disk error  
message displays. 

A diskette has been left in the 
drive during startup. 

When drive activity stops, remove the diskette and press the 
spacebar. The PC should start up. 

PC appears locked 
up and won’t turn off 
when the On button 
is pressed. 

PC is not working. Press and hold the On button until the PC turns off. 

The unit temperature was 
exceeded.  

Unit is in an exceedingly hot environment. Let it cool down. 

Ensure PC air vents are not blocked and internal fan is 
running. Note that your PC may not have an internal fan. 

The unit temperature was 
exceeded because the PC was 
functioning with the cover or 
access panel removed. 

Replace cover or access panel, and let the PC cool down 
before attempting to turn on power to the PC. 

PC powered off 
automatically. 

Processor or system fan has 
failed. 

Refer to the Warranty and Support Guide to contact Support 
for replacement details. Note that your PC may not have an 
internal fan. 
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A 
adding a menu, 77 
adding images, 75 
adjusting speaker volume, 80 
America Online, troubleshooting, 87 
appendable disc, 58 
audio wizard, 38 
automatic recording options 

setting, 63 
B 

burning CDs, 53 
buttons 

Compaq, 15 
customizing, 19 
E-Mail, 16 
Help, 15 
Mute, 16 
On, 5 
Power, 5 
Search, 16 
special keys, 14 
Standby, 15 
user, 15 

C 
cables, for connecting a TV, 41 
cannot play DVD movie on  

DVD player, 82 
cannot play music CD on stereo, 82 
capturing 

requirements, 72 
video and images, 71 

card reader, memory, 39 
carpal tunnel syndrome, 3 
CD/DVD 

keyboard button, 16 
making recovery discs, 21 
removing, 81 
troubleshooting, 79 

Compaq Connections, using, 22 
Compaq keyboard button, 15 
connect the speakers 

6-connector PC, 35 
connecting 

a TV, 41 
multichannel speakers  

3-connectors, 32 
connectors 

PC back, 4 
converting recorded TV, 78 
copying a DVD or CD, 60 
country/region codes, 50 
creating 

recovery CD/DVDs for the PC, 63 
creating CDs, 53 
customizing keyboard buttons, 19 

D 
desktop, 8 
device conflict, resolving, 86 
device not working, 89 
digital pictures, 39 
disc 

CD-R, 66 
CD-RW, 66 
compatible file formats, 65 
double-layer DVD+R, 65 
DVD+R, 65 
DVD+RW, 66 
feature and compatibility, 67 
quick reference, 65 

disc and drive compatibility 
information, 64 

disconnecting TV, 46 
double-layer DVD+R discs, 65 
double-sided DVD, 48 

Index 
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DVD 
cannot play movie DVD on DVD 

player, 82 
keyboard button, 16 
multiple session recording of data, 82 
troubleshooting, 79 

DVD player, multichannel audio, 33 
E 

edit 
video files, 74 

e-mail 
keyboard button, 16 

equalizer 
sound effect manager  

(6-connector), 37 
erasing a DVD or CD, 60 
error 

capturing video, 82 
Invalid system disk, 90 
music titles do not appear, 82 
Non-system disk or disk error, 90 

F 
file formats, 65 

H 
hard disk drive 

connecting an HP Personal Media 
Drive to the PC, 26 

Help 
commonly asked questions, 1 
finding answers, 1 

Help button, 15 
HP Personal Media Drive, 25 

activity and power lights, 27 
automatic on and off feature, 26 
disconnecting the drive, 29 
inserting a drive, 27 
location and drive letter, 27 
storing files, 28 

I 
image files, 62 

adding, 75 
installing software programs, 6 
Instant Support, 22 
Internet 

finding an ISP, 5 
keyboard button, 16 
organizing destinations, 8 
signing up with an ISP, 5 

Invalid system disk error, 90 

iTunes, 15, 54 
creating music CD, 54 
features, 69 
playing music CDs, 47 

K 
keyboard 

customizing buttons, 19 
features, 11, 12 
troubleshooting, 88 
types of buttons, 14 
using, 11 
wireless, 14 

L 
LEDs, defined, 13 

M 
manuals, online, 23 
memory card reader 

card types, 39 
using, 39 

microphone 
6-connector, using, 36 
using with multichannel speakers, 33 
using, (6-connector), 36 

model number for the PC, viewing, 7 
monitor, 5 

troubleshooting, 84 
mouse 

troubleshooting, 88 
Multi-channel Sound Manager, 32 
multichannel speakers, 31 

connecting 3-connectors, 32 
selecting for 3-connector PC, 32 
selecting for 6-connector PC, 35 
using a microphone, 33 

multiple session recording for DVD, 82 
music 

about burning a music CD, 58 
burning CD, 54 
keyboard button, 15 
playing with iTunes, 47 
playing with Windows Media  

Player, 48 
music titles do not appear, 82 
Mute button, 16 
N 
no sound, 80 
Non-System disk or disk error, 90 

O 
online manuals, 23 
onscreen guides, 9 
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optical drive quick reference, 68 
organizing Internet links and the PC, 8 

P 
PC 

keyboard not working, 88 
no sound, 80 
organizing information, 8 
problem turning on, 90 
problem, powered off, 90 
problem, won’t turn off, 90 
registering, 7 
running tests, 22 
serial number, viewing, 7 
setting it up, 3 
transferring files and settings to new 

PC, 7 
troubleshooting, 79 
turning on, 5 
viewing PC image on TV, 42 

PC Help & Tools, 9 
peripherals, 5 
Pictures (Photos) button, 15 
Print button, not working, 88 
printer 

troubleshooting, 89 
problem 

cannot add data to DVD, 82 
cannot play DVD movie on my DVD 

player, 82 
cannot play music CD on stereo, 82 
keyboard, 88 
monitor, 84 
mouse, 88 
no sound, 80 
PC not working, 88 
PC powered off, 90 
PC won’t turn off, 90 
printer, 89 
troubleshooting, 79 
turning on PC, 90 

problem resolution, troubleshooting, 79 
product notices, 22 

R 
RealOne Player 

features, 69 
RecordNow!, 55 

copying a DVD or CD, 60 
creating music CDs, 56 
erasing a DVD or CD, 60 
features, 70 
image files, 62 

removing files, 61 
storing files on a DVD or CD, 58 

recovery CD/DVDs for the PC, 63 
recovery discs, 21 
registering your PC, 7 
removing files, 61 
repair software, 8 
repetitive strain injury (RSI), 3 
resolving a device conflict, 86 
retasking 

audio connectors, 38 
S 

safety warnings, 3 
serial number for the PC, 7 
setting up PC, 3 
shortcut icons, 8 
software 

installing, 6 
software quick reference, 68 
software repair wizard, 8 
solving common problems, 79 
sound connectors, 31 

3-connectors PC, 32 
6-connectors PC, 34 

Sound Effect Manager, 37 
audio wizard, 38 
retasking connectors, 38 

sound manager, multichannel, 3-
connectors, 32 

sound manager, multichannel, 6-
connectors, 37 

sound, troubleshooting, 80 
speaker system, 31 
speakers, 31 

multichannel, 31 
special offers, 22 
Standby button, 15 
storing files 

about storing data files, 59 
Support 

messages, 22 
system recovery programs, 21 
System Restore, 21 
system updates, 22 

T 
television, viewing PC image  

on a TV, 41 
tips, 22 
transferring information to  

your new PC, 7 
troubleshooting, 79 
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turning on PC 
first time, 5 
troubleshooting, 79 

TV 
connecting, 41 
disconnecting, 46 

TV-out, 41 
cables, 41 
connecting a TV set, 41 
disabling TV option, 44 
viewing PC image on TV, 42 

U 
updating, system, 22 
USB 

connecting an HP Personal Media 
Drive to the PC, 25 

User button, 15 
V 

VCD 
playing with Windows Media  

Player, 51 
playing with WinDVD, 50 

VHS, recording to DVD, 78 
video capture error, 82 
Video CDs 

playing with Windows Media  
Player, 51 

playing with WinDVD, 50 
video files 

recording, 63 
video recording length, 66 
viewing onscreen guides, 9 
volume 

adjusting, 80 
controls, 16 

W 
Windows Media Player 

creating music CDs, 54 
features, 69 
play music CDs, 48 
playing video CDs, 51 

Windows Movie Maker 2.0 
features, 69 

Windows XP 
creating data CDs, 55 

WinDVD, 33 
control panel, 49 
features, 70 
playing DVD movies, 48 
playing video CDs, 50 

WinDVD Creator 
adding a menu, 77 
adding audio effects, 76 
adding images, 75 
adding title effects, 76 
adding transition effects, 76 
capture, 71 
edit, 71 
editing video files, 74 
help, 71 
make movie, 77 
media library, 72 
preview window, 72 
recording VHS video files direct to 

DVD, 78 
storyboard, 72 

wireless keyboard, 14 
wizard 

audio for Sound Effect Manager, 38 
working in comfort, 3 

 

 

 


